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Report Studio 
 
The User Interface 
The IBM Cognos Report Studio user interface has two panes, an explorer bar, and a work area to help you 
create reports. 
 

 
 
We recommend that you use a screen resolution of at least 1024 by 768 pixels. 
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Properties Pane 
 
The Properties pane lists the properties that you can set for an object in a report. 
 
You can obtain additional information about a property by selecting it and pressing F1. For example, you 
can view the list of objects that use each property. 
 
When you specify a value for a property, press Enter, click another property, or save the report to ensure 
that the value is saved. 
 
Tip: To view a description of the currently selected property at the bottom of the pane, from the View 
menu, click Property Descriptions. 
 
 
Explorer Bar 
 
Pause the pointer over the following buttons on the Explorer bar to work with different parts of a report: 
 

 the page explorer button . 
You use Page Explorer to view or create new report pages and prompt pages or to create and modify 
classes. 

 

 the query explorer button . 
You use Query Explorer to create or modify queries in relational reporting or dimensional reporting 
and to perform complex tasks, such as defining union joins and writing SQL statements. 

 

 the condition explorer button  
You use Condition Explorer to work with variables to define conditions in a report. 
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Creating a Report 
 
When you create a report, you are actually creating a report specification. The report specification defines 
the queries and prompts that are used to retrieve data and the layouts and styles used to present the data. For 
simplicity, the report specification is named by the same name as the report. 
 
Creating a report includes 
 creating basic reports 
 understanding how to create accessible reports 
 viewing lineage information for data items 
 
 

Creating a Basic Report 
Creating a basic report involves 
 

 specifying the data package 
 

 choosing a basic report layout 
 

 adding data 
 

 inserting a single data item 
 

 validating the report 
 

 saving the report 
 

 running the report 
 

 setting PDF page options 
 
You can then lay out the report and manipulate the data that will appear in the report. For information about 
other tasks that are specific to a report type, see "Lists", "Crosstabs", "Charts", and "Maps". 
 
 
Specify the Data Package 
 

Specify the package that will provide items for the report. 
 
The packages that you use to generate reports are based on models that are created in the modeling tool, 
Framework Manager. A model is a set of related objects, such as query subjects, dimensions, filters, and 
calculations. When you open a package in IBM Cognos 8, these model objects are visible in the left frame. 
 
The package must be previously created and published to the IBM Cognos Connection portal. For more 
information, see the Framework Manager User Guide. 
 
Steps 

1. Open Report Studio with the package you want to use. 
 
2. In the Welcome dialog box, choose whether to open a new or existing report or template: 

 To create a new report or template, click Create a new report or template and choose a 
basic report layout. 
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Tip: You can specify a language other than the default language for your package by clicking 
on the ellipsis (...) button to the right of the Package field, clicking the Language ellipsis 
button in the Report Package dialog box, highlighting the desired language, and then 
clicking OK. As stated on the language selection dialog box, items such as separators and 
decimals may need to be manually updated for language-specific syntax rules as a result of 
your selection. 

 
 To open an existing report or template, click Open an existing report or template and select 

a report. 
 

Objects from the selected package, such as query items, appear on the Source tab. 
 
Tip: You can later change packages. 
 
 
Refresh the Package 
 

If the package that a report is using has changed, refresh it to ensure that you are working with the latest 
version. 
 
Steps 

1. In the Insertable Objects pane, click the Source tab . 
 
2. Right-click in the Source tab and click Refresh. 
 
Tip: You can also close and reopen the report to upgrade it to the latest version of the package. 

 
Choose a Basic Report Layout 
 

Report Studio includes several basic report layouts that include report objects, such as lists, crosstabs, 
maps, repeaters, and headers and footers. You can also choose to start with a blank report or open an 
existing report. 
 
Tip: The Budget vs. Actual sample report in the GO Data Warehouse (analysis) package is based on a 
basic report layout. 
 
Steps 

1. From the File menu, click New . 
 

2. If you want to change the package, click the ellipsis (...) button and click a different package. 
 

3. Choose a basic report layout: 
 

 To create a report from a blank layout, double-click Blank. 
 

 To create a report using one of Report Studio's predefined report layouts, double-click the 
layout. 

 

 To create a new report template that can be applied to reports created in Query Studio or 
Analysis Studio, double-click Report Template. 

 

 To create a financial report using the basic financial report layout, double-click Financial 
Report.  
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 To create a new report using another report, double-click Existing, locate the report, and click 
Open. 

 
Tip: In the Type box, click Templates to see only existing templates. 
 

The basic report layout appears in the report page. 
 
 
Add Data 
 

Select the data items you want to appear in your report. 
 
For more information about adding data to a relational style report, see "Add Relational Data to a Report". 
For more information about adding data to a dimensional style report, see "Add Dimensional Data to a 
Report". 
 
 
Data Source Icons 
 

Each object in the data source has a representative icon. You can insert all of the following objects in a 
report, except for packages and dimensions. 
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Step 

 In the Insertable Objects pane, on the Source tab , drag data items to the report object. 
 

A flashing black bar indicates where you can drop a data item. Data items in the report appear on the 

Data Items tab . 
 
Insert a Single Data Item 
 

You can insert a single data item anywhere in your report using the singleton object. The singleton object 
retrieves only the first row value for that query. Inserting a single data item is useful when you want to 
show a value that is independent from the rest of the values in the report or when you want to insert some 
boilerplate text, such as a company name and address. For example, you can add the total revenue value in 
the header of each page in a report. 
 
You can associate multiple singleton objects with a single query in relational reporting and dimensional 
reporting to optimize performance, such as when all the data items in the singleton are from the same 
database table. In addition, two or more singletons can reference data items from the same query. This is 
useful when using a single query is more efficient to display a set of single values than using multiple 
queries.  
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You can also filter the data item in the singleton. For example, you can show the total revenue for only the 
year 2007. 
 
Queries that are associated to a singleton object are not supported when producing report output in 
delimited text (CSV) format. 
 
Tip: The Returns by Damage, Failed Orders and Complaints in 2006 sample report in the GO Data 
Warehouse (analysis) package includes a singleton. For more information about  
 
Steps 

1. In the Insertable Objects pane, on the Toolbox tab , drag Singleton to the report. 
 

An empty data container is created. 

2. From the Insertable Objects pane, on the Source tab , drag a data item into the Singleton 
container. 

 

Tip: To create a singleton, you can also drag a data item anywhere in your report layout. 
 

3. To change the query associated to the singleton object, in the Properties pane, double-click the 
Query property and make changes. 

 
When the report is run, the first row value for the data item is retrieved. 
 

 
Save a Report 
 

Save your report to preserve the modifications you made. 
 
Reports are saved to the IBM Cognos 8 server. You can also save your report on your computer. 
 
Steps 
 

1. From the File menu, click Save  or click Save As to save a copy of the report under a 
different name. 

 

2. If you are saving the report for the first time, specify where to save the report and type a file name. 
For information about setting up folders in IBM Cognos Connection for your reports, see the IBM 
Cognos Connection User Guide. 
 

3. Click Save. 
 
 
Run a Report 
 

Run your report to see the data that is retrieved. 
 
You can also run a report or a group of reports in IBM Cognos Connection. Furthermore, you can save 
report outputs to a file system. For more information, see the Administration and Security Guide. 
 
You can specify not to render a report page if it does not contain any data. 
 
If you run a report that uses functions or features not supported by the data source, an error message 
appears. We recommend that you periodically test your reports while you author them in Report Studio to 
ensure that you do not encounter multiple error messages when you run the report.
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Steps 
 

1. Open a report. 
 

2. If you want to clear parameter values stored on the IBM Cognos 8 server, from the File menu, 
click Clear Parameter Values. 

 

Parameter values stored by the IBM Cognos 8 server include signon, validation, and prompt 
information. For example, if you define two data source connections in IBM Cognos Connection 
that point to the same data source, you are prompted to choose one when you run a report. 
This information is stored so that you are not prompted each time you run the report. 
 

3. If you want to view only the tabular data, from the Run menu, click View Tabular Data  . 
 

If the report contains multiple queries, you must first click an object, such as a list or crosstab, that 
uses the query for which you want to view the tabular data. 

 

Use this command to ensure that the right results appear. For example, you create a calculation 
and you want to ensure it is giving you the results you want. 
 

Tip: You can also view tabular data in Query Explorer, which is useful when you are building 
queries. 
 

4. If you want to set run options, from the Run menu, click Run Options. 
 

The default value is the value of the selected corresponding run option in IBM Cognos 
Connection. 
 

The run options that you set apply only to the current session. When you close Report Studio, the 
options return to the default settings. 
 

5. Change any values for the current session. 
 

 



 - 11 - 

 
 
6. From the Run menu, click one of the options to produce the report in the format you want. 

 
You can produce a report in HTML, PDF, CSV, various Excel formats, and XML. You cannot 
produce a report in CSV format if you have more than one query defined in the report unless the 
additional queries are used for prompts. 
 

The report runs in Cognos Viewer. Once the report has finished running, you can run the report again 
in the same format or in a different format. If you run the report again in CSV or XLS format, the 
report will appear in a new browser window. 
 
The options available in Cognos Viewer depend on the capabilities set by the administrator for each 
user. For more information, see the Administration and Security Guide. 
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View Lineage Information for a Data Item 
 

View lineage information of a data item to see what the item represents before you add it to a report. 
Lineage information traces the metadata of an item back through the package and the data sources used by 
the package. Lineage also displays any data item filters that were added by the report author or that were 
defined in the data model. Viewing lineage information ensures that you add the correct data items to a 
report. For example, you can view the lineage information of a model calculation to see how it was created. 
 
Note: Lineage is not supported in reports that are not linked to packages. 
 
You can use the lineage tool that comes with IBM Cognos 8, or you can use another lineage tool by 
specifying the URL to the tool in IBM Cognos Administration. Note that if the URL source is secured, the 
source must be able to prompt users for a password because IBM Cognos 8 does not pass security 
information. IBM Cognos 8 also supports the IBM Metadata Workbench as a lineage tool. For more 
information about configuring other lineage tools, see the Administration and Security Guide. 
 
Tip: The Customer Returns and Satisfaction sample report in the GO Data Warehouse 
(analysis) package includes lineage information. 
 
 
The IBM Cognos 8 Lineage Tool 
 

The IBM Cognos 8 lineage tool includes two views: the business view and the technical view. 
 
Business View 
 

The business view shows high-level textual information that describes and explains the data item and the 
package from which it comes. This information is taken from IBM Cognos Connection and the Framework 
Manager model. 
 
Technical View 
 

The technical view shows a graphical representation of the lineage of the selected data item. The lineage 
traces the data item from the package to the data sources used by the package. 
 
When you click an item, its properties appear below it. If you click an item in the Package area, you see 
the model properties of the item. If you click an item in the Data Sources area, you see the data source 
properties of the item. 
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Saved Reports 
 

You can also view lineage information when you run a saved report in IBM Cognos Connection. 
 

For example, you can click a cell in a crosstab to see how the cell value was calculated. To view lineage 

information, click an item in the report and then click the Lineage button . If you or an administrator 
runs a saved report with the IBM Cognos 8 lineage tool, both the business view and the technical view are 
visible. Report consumers can see only the business view. In addition to the Package and Data Sources 
areas, a Report area exists when looking at the technical view. 
 

You cannot use lineage information to troubleshoot queries. For example, lineage information will not 
explain why a data item is double counted. Also, you cannot view lineage information when running a 
report from a mobile device. 
 

To access lineage information, your administrator must configure lineage in IBM Cognos Administration. 
Also, the administrator must enable the lineage capability and grant read permission for you on the report. 
 
Step 

 In the Insertable Objects pane, on the Source tab , right-click the data item and click Lineage. 
 

Tip: You can view lineage information for multiple data items at the same time by first Ctrl+clicking 
the items. The IBM Metadata Workbench does not support viewing lineage for multiple data items at 
once. 
 

The lineage tool opens showing the lineage information of the selected data item. 
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Lists 
Use list reports to show detailed information from your database, such as product lists and customer lists. 
 

A list report is a report that shows data in rows and columns. Each column shows all the values for a data 
item in the database or a calculation based on data items in the database. 
 
 

 

 
For information about how to create a list report, see the Report Studio Quick Tour.
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Set List Properties 
 

Format lists to give them the appearance you want. You can specify formatting for individual column titles 
or bodies or for all columns in a list. When you specify formatting for all columns in a list, the formatting is 
automatically applied to new columns you subsequently add. 
 

You can also quickly format lists by applying table styles. 
 
Steps 

1. To format an individual column, do the following: 
 

 Click the column title or column body. 
 

To format the text in the column title or the data in the column body, click the unlock 
 

button in the toolbar and then click the title or body. 
 

To format the whole column, click the select ancestor button  in the title bar of the 
Properties pane and click List Column. 
 

 In the Properties pane, set the property value. 
 

For example, to specify a background color, click Background Color and choose the color. 
 

2. To format all columns, do the following: 
 

 Click a column in the list. 
 
 To format list column bodies, click the select ancestor button in the title bar of the Properties 

pane and click List Columns Body Style. 
 

 To format list column titles, click the select ancestor button in the title bar of the Properties 
pane and click List Columns Title Style. 

 
 To format entire columns, click the select ancestor button in the title bar of the Properties 

pane and click List Columns. 
 

 To format the entire list, click the select ancestor button in the title bar of the Properties pane 
and click List. 

 
 In the Properties pane, set the property value. 

 
For example, to specify a background color, click Background Color and choose the color. 
 

Formatting for specific columns overrides formatting for entire columns. For example, you specify red as 
the background color for a specific column body and green as the background color for all columns. When 
you run the report, the specific column body is red and the remaining columns in the list are green. New 
columns added to the list will be green. 
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Crosstabs 
Use crosstab reports to show information in a more compact form than in a grouped list. For example, 
create a crosstab report to show total sales by product line generated by each sales representative. 
 
Like list reports, crosstab reports are reports that show data in rows and columns. However, the values at 
the intersection points of rows and columns show summarized information rather than detailed information. 
 

 
 
For information about how to create a crosstab report, see the Report Studio Quick Tour. 
 
Using crosstabs includes: 
 

 setting crosstab properties 
 

 creating single-edged crosstabs 
 

 creating nested crosstabs 
 

 specifying the default measure 
 

 swapping columns and rows 
 

 indenting data 
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Set Crosstab Properties 
 

Format crosstabs to give them the appearance you want. You can specify formatting for rows, columns, and 
fact cells in a crosstab or for the entire crosstab. When you specify formatting for all rows, columns, fact 
cells, or the crosstab, the formatting is automatically applied to any new items you add. 
 
Order of Styles Applied 
 

If you apply the same styles, such as font color, to crosstab rows, columns, and crosstab intersections, the 
styles are applied in the following order: 
 

 crosstab fact cells 
 

 fact cells in the outermost rows 
 

 fact cells in the innermost rows 
 

 fact cells in the outermost columns 
 

 fact cells in the innermost columns 
 

 crosstab intersections 
 
The style applied to the last object in the list overrides styles applied to previous objects. In addition, class 
styles are applied before styles that you apply manually. 
 
You can also quickly format crosstabs by applying table styles and add white space to a crosstab by 
inserting crosstab space objects. 
 
Steps 
 

1. To format the entire crosstab, do the following: 
 

 Click anywhere in the crosstab. 
 
 Click the select ancestor button  in the title bar of the Properties pane and click 

Crosstab. 
 
 In the Properties pane, set the property value. 

 
For example, to specify a background color, click Background Color and choose a color. 

 
2. To format all rows, columns, or fact cells, click a row, column, or fact cell in the crosstab and then 

do the following: 
 

 If you clicked a row, click the select ancestor button in the title bar of the Properties pane and 
click Crosstab Rows. 

 

 If you clicked a column, click the select ancestor button in the title bar of the Properties pane 
and click Crosstab Columns. 

 

 If you clicked a fact cell, click the select ancestor button in the title bar of the Properties pane 
and click Crosstab Fact Cells. 

 

 In the Properties pane, set the property value. 
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For example, to specify a background color, click Background Color and choose the color. 
 
Tip: You can also right-click the row or column and click Select Fact Cells. 
 

3. To format all crosstab cells for a specific row or column, do the following: 
 

 Click the row or column. 
 

 Click the select ancestor button in the title bar of the Properties pane and click Crosstab 
Member Fact Cells. 

 
Tip: You can also right-click the row or column and click Select Member Fact Cells. 

 
 In the Properties pane, set the property value. 
 

For example, to specify a background color, click Background Color and choose the color. 
 

4. To format all row or column titles, do the following: 
 

 Click a row or column title. 
 

 Click the select ancestor button in the title bar of the Properties pane and click Crosstab 
Rows or Crosstab Columns. 

 
 In the Properties pane, set the property value. 

 
For example, to specify a background color, click Background Color and choose the color. 

 
5. To format an individual row, column, or intersection, do the following: 
 

 Click the row, column, or intersection. 

Tip: To format the data in a row, column, or intersection, click the unlock button  in the 
toolbar and then click the text item to format. 

 

 In the Properties pane, set the property value. 
 

For example, to specify a background color, click Background Color and choose the color. 
 

Tip: In cases where fact cell formatting applied to rows conflicts with fact cell formatting 
applied to columns, you can set the Fact Cells Precedence property in the Properties pane to 
determine whether the row formatting or the column formatting has precedence. To set this 
property, click anywhere in the crosstab, click the select ancestor button in the title bar of the 
Properties pane, and click Crosstab. 
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Create a Single-Edge Crosstab 
 

Create a single-edge crosstab report to show data in a list-like form. For example, to show the quantity of 
products sold for each year and for each order method, you could create a crosstab with Order Year and 
Order Method as rows and Quantity as the measure. 
 
Steps 
 

1. From the File menu, click New. 
 

2. Click Crosstab and click OK. 
 

3. In the Insertable Objects pane, on the Source tab , drag data items to the Rows or Columns 
drop zone. 

 
A black bar indicates where you can drop the data item. 
 

4. Repeat step 3 to insert additional data items: 
 

 If you dragged the data item in step 3 to the Rows drop zone, drag the additional items above 
or below the first item. 

 

 If you dragged the data item in step 3 to the Columns drop zone, drag the additional items to 
the left or right of the first item. 

 
5. To add measures to the crosstab, drag the measures to the Measures drop zone. 

 
When you run the report, a crosstab is produced that has only one edge. 

 
Create a Nested Crosstab 
 

Nest data in a crosstab report to compare information by using more than one data item in a column or row. 
For example, a report shows the number of sales by product line for the past fiscal year. You decide to add 
a data item to further break down the number of sales by quarter. 
 
When nesting columns in a crosstab report, there are four distinct drop zones where you can insert a new 
data item. The drop zone you choose will define the relationship between the data item and the column. 
 
Rows 
 

The following relationships are created when you insert a data item as a row: 
 

 Inserting a data item to the left or right of a column creates a parent-child relationship between them. 
 

When you insert a data item to the left of a column, the data item becomes a parent to the column. 
When you insert a data item to the right of a column, the data item becomes a child of the column. 

 

 Inserting a data item above or below a column creates a union relationship between them. 
 
Columns 
 

The following relationships are created when you insert a data item as a column: 
 

 Inserting a data item to the left or right of a column creates a union relationship between them. 
 

 Inserting a data item above or below a column creates a parent-child relationship between them. 
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When you insert a data item above a column, the data item becomes a parent to the column. When you 
insert a data item below a column, the data item becomes a child of the column. 
 

For example, you have a crosstab with Product line as rows and Quantity and Revenue as nested rows. For 
columns, you have Order method with Country as a nested column. In this crosstab, 
 

 Product line is a parent to Quantity and Revenue. 
 

 Quantity and Revenue are peers. 
 

 Order method is a parent to Country. 
 
Steps 

1. In the Insertable Objects pane, on the Source tab , click the data item to add. 
 
2. Drag the data item to the report as a nested column or nested row. 

 
A black bar indicates where you can drop the data item. 

 

3. Repeat steps 1 to 2 to add other nested columns or rows. 
 

Tip: If you add more than one measure to a crosstab, all measures appear as columns. You cannot 
have one measure appear as a row and another as a column. To make all measures appear as rows, 
swap columns and rows. 
 

 

Specify the Default Measure 
 

You can specify the default measure for crosstabs and certain chart types. Specify the default measure to be 
used when the measures cannot be determined by what is on the edges. For example, you create a crosstab 
with Order method as rows and Product line as columns. You add Quantity and Revenue as nested rows, 
making Order method their parent. You then add Country under Order method. Since there is no measure 
specified for Country, you specify the default measure so that data is returned for each country. 
 
In crosstabs, Report Studio automatically sets the default measure when you insert a measure into the 
crosstab cells. 
 
Steps 

1. To specify the default measure for a crosstab, do the following: 
 

 Click any part of the crosstab, and then click the select ancestor button  in the title bar of 
the Properties pane. 

 

 Click Crosstab. 
 

 Set the Default Measure property to the default measure. 
 

2. To specify the default measure for a chart, drag the measure to the Default measure box in the 
chart. 
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Swap Columns and Rows 
 

Swap columns and rows to look at information from a different perspective. This may help you discover 
high and low points in the data that you hadn't previously noted. 
 
You can only swap columns and rows in a crosstab or chart. 
 
Step 

 From the toolbar, click the swap rows and columns button . 
 
In the report, the rows become the columns and the columns become the rows. 

 
Indent Data 
 

You can indent crosstab node members to set them apart from surrounding data. 
 
When you insert a hierarchy in rows, all members are automatically indented according to their level. By 
default, the first member in a set is not indented. If you insert a hierarchy in columns, the members are not 
automatically indented. You can change the indentation properties of members in the report. 
 
Relative indentation means that the member will shift by one tab when the member's level increases 
relative to the previous member in the hierarchy. 
 
Indenting based on the level in the hierarchy means that the member will shift the number of tabs 
equivalent to the level in the hierarchy. 
 
You can also indent objects by applying padding. 
 
Level Indentation is not supported for Excel 2002 and Excel 2000 Single Sheet format reports. 
 
Steps 
 

1. Click the crosstab node member to indent. 
 

2. In the Properties pane, set the Level Indentation property to your indentation type, 
length, and direction. 

 
 

Example - Add Aggregate Data to a Crosstab 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a report showing sales by order method to determine which methods are generating the 
most revenue and the highest sales volume. 
 
Steps 
 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 

2. In the Welcome dialog box, click Create a new report or template. 
 

3. In the New dialog box, click Crosstab and click OK. 
 

4. In the Insertable Objects pane, on the Source tab :  
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 Expand Sales and Marketing (query) and Sales (query). 
 

 Expand Product and double-click Product line to add it as rows. 
 

 Expand Order method and double-click Order method to add it as columns. 
 

 Click Product type and drag it just to the right of Product line. 
 

 Product type is now nested in Product line. 
 

 Expand Sales fact and drag Quantity to the Measures drop zone to add it as a measure. 
 

 Drag Revenue to the right of Quantity to add it as a second measure. 
 

 Tip: Drop Revenue into the crosstab when you see a vertical bar between the Product type 
column and the Order method column. 

 

5. Click any part of the crosstab, and then click the select ancestor button  in the title bar of the 
Properties pane. 

 

6. Click Crosstab. 
 

7. In the Properties pane, double-click the Font property. 
 

8. In the Size box, click 8pt and click OK. 
 

9. Click one of the measures. 
 

10. Click the aggregate button  and click Maximum. 
 

When you run the report, you can see that for camping equipment, Cooking Gear generated the 
highest sales volume for the Special order method and Tents generated the most revenue. Tents 
ordered by the Web order method generated the largest revenue. 
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Charts 
You can use Report Studio to create many chart types, including column, bar, area, and line charts. 
You can also create custom charts that combine these chart types. 
 
Charts are similar to crosstabs in the way their data is organized. The display is different, but charts show 
the intersection of data the same ways as crosstabs; for example, you can see the revenue for golf 
equipment in 2004. 
 
For information about different chart types, see "Chart Types". 

Tip: To view the available chart types, from the File menu, click New, and then double-click the chart icon  
You can also view the available chart types by adding a Chart object from the Toolbox tab in the Insertable 
Objects pane to an existing report. 
 
You can also find information about how to create a chart in the Report Studio Quick Tour. 
 
 
 

Creating Charts 
 

To create charts, you drag items from the Insertable Objects pane to the following drop zones: 
 

 Measures 
 

 columns, bars, lines, areas, or points to represent data series 
 

 groups, clusters, or stacks to represent categories of related data series 
 
The following illustrates a typical chart as it appears in Cognos Viewer. 
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The following illustrates the same chart as it appears in the Report Studio interface. The y-axis is selected, 
and the axis titles are displayed. 

 
 
Chart Types 
 

Charts are a graphical way of presenting data. For example, you can create a chart to visualize how actual 
sales compare to projected sales or to discover whether sales are falling or rising over quarterly periods. 
 
Some chart types are not supported for Microsoft Excel output or appear differently.  
 
Chart Elements 
 

The following example shows the most common chart elements. You can add extra elements such as 
baselines and notes using Report Studio. 
 

 



 - 25 - 

Axes 
Axes are lines that provide a frame of reference for measurement or comparison. 
 

The y-axis refers to measures of quantitative data, such as sales figures or quantities. Charts may have more 
than one y-axis. 
 

The x-axis or ordinal axis plots qualitative data, such as products or regions. It runs horizontally, except in 
bar charts. 
 

The z-axis is the vertical axis in a 3-D chart. 
 

Gridlines 
Axes are lines that provide a frame of reference for measurement or comparison. Major gridlines extend 
from the tick marks on an axis and run behind the data markers. 
 
Data Series 
A data series is a group of related data points plotted in a chart. Each series has a unique color or pattern 
and is described in the legend. 
 

In the example chart, the data series are order years 2004, 2005, and 2006. 
 
Legend 
A legend is a key to the patterns or colors assigned to the data series or categories in a chart. 
 

Categories 
Categories are groups of related data from the data series plotted on the x-axis. Categories of multiple data 
series are shown together using clustered and stacked data markers. 
 

In the example chart, the categories are the product lines of The Great Outdoors Company in clustered 
columns. 
 

Columns, Lines, and Areas 
Charts use columns, lines, and areas as visual representations of data points. Other examples of visual 
representations include horizontal bars, points, and bubbles. 
 
Choosing a Chart Type and Configuration 
 

To choose a chart type, consider what you want the chart to illustrate. Different chart types and 
configurations emphasize different things. 
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Example - Create a Column Chart to Plot Order Trends 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a chart that shows the contribution that each order method makes to revenue. 
You decide to create a column chart because it emphasizes the values of each order method for each year. 
 
Steps 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 

2. In the Welcome dialog box, click Create a new report or template. 
 

3. In the New dialog box, click Chart and click OK. 
 

4. In the Chart group pane, click Column. 
 

5. In the Chart type pane, click Column with 3-D Visual Effect and click OK. 
 

6. In the Insertable Objects pane, on the Source tab , expand Sales and Marketing (query) and 
Sales (query). 

 

7. Add the following data items: 
 

 From Sales fact, drag Revenue to the Default measure (y-axis) drop zone. 
 From Time dimension, drag Current year to the Series drop zone. 
 From Order method, drag Order method to the Categories (x-axis) drop zone. 

 

8. Click the Current year data item in the Series drop zone, and then, from the Data menu, click 
Sort and click Sort Ascending . 

 

9. Save the chart with the name Order Trends in the Public Folders. 
 

10. Run the report. 
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Create a Win-Loss Chart 
 

You can use win-loss charts to visualize win-loss trends. 
 
A win-loss chart is a microchart in which the value of each column is either 1 or -1, often denoting a win or 
loss. 
 
Win-loss charts use two measures (the default measure and the win-loss measure) and no series. 
 
Note 
Axis lines are not shown for win-loss charts in Excel output. 
 
Steps 

1. In Report Studio, from the File menu, click New. 
 

2. In the New dialog box, click Chart, and then click OK. 
 

3. In the Chart group pane, click Microchart. 
 

4. In the Chart type pane, select the win-loss chart, and then click OK. 

5. In the Insertable Objects pane, on the Source tab , click a data item to add to the chart, and 
drag it to the Categories (x-axis) drop zone. 

 

6. Drag a measure, query calculation, or calculated member to the win-loss section of the Measures 
drop zone. 

 
Note: If your win-loss calculation specifies a measure, you may not need to define a default 
measure. 

 

7. Click the chart object. 
 

8. In the Properties pane, under General, specify a value for the Win-Loss Threshold property. 
 

9. Run the report. 
 
Example - Create a Win-Loss Chart 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. 
 
Using the GO Sales (analysis) package, you want to create a win-loss chart that shows whether the gross 
margin is above a certain threshold. Quarters where the gross margin is greater than 10000 are represented 
as wins. The rest are represented as losses. 
 
Steps 
 

1. Open Report Studio with the GO Sales (analysis) package. 
 

2. In the Welcome dialog box, click Create a new report or template. 
 

3. In the New dialog box, click Chart, and then click OK. 
 

4. In the Chart group pane, click Microchart. 
 

5. In the Chart type pane, select the win-loss chart, and then click OK. 
 

6. From Sales in Sales (analysis), drag Margin to the win-loss section of the Measures drop zone. 
 

7. From Time dimension in Sales (analysis), drag Quarter to the Categories (x-axis) drop zone. 
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8. Click the chart object. 
 

9. In the Properties pane, under General, specify 10000 as the value for the Win-Loss Threshold 
property. 

 

Tip: Alternatively, from the Toolbox tab you can drag a calculated member or query calculation 
to the win-loss section of the Measures drop zone and use the Expression editor to create a 
calculation. 
 

10. Run the report. 
 

Your report will look like this. 
 

 
 
 

Show Data Points or Value Markers 
 

You can specify and format data points or value markers in line charts. Data points represent series values 
for each category on the y-axis. Value markers represent statistically significant values, such as open, high, 
low, and close values.  
 

You can also add markers at other positions on the chart.  
 
Notes 
 

You cannot show value markers under the following conditions: 
 

 The Data points option is selected. 
 

 The configuration of the line chart is stacked or 100 percent stacked. 
 

 The Line property is set to No, creating a point chart. 
 
Steps 
 

1. Click under Series in the chart template to view the line properties. 
 
2. In the Properties pane, under General, double-click the Show Data Points property to show data 

points or value markers: 
 

 To show or format data points, click Data points and specify the point shape and point size. 
 
The point color is defined by the chart palette. For more information, see "Customize the 
Colors of a Chart". 
 

 To show or format value markers, click Value markers and specify the markers to show. 
For each marker, specify the shape and marker size. Click the Color link to change the 
marker color. 
 

Tip: To remove all data points and value markers, in the Show Data Points dialog box, select 
None. 
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Customize the Colors of a Chart 
 

You can use the chart palette to control the colors of the columns, lines, or areas in a chart. For example, if 
you know that Telephone is the first in a data series of order methods and you want it to appear in blue, you 
use the palette to ensure that the first item in the series is blue. 
 
You use a unique color, pattern, or gradient fill for each series in the chart. Patterns are useful when the 
report is printed on a black and white printer because colors do not print well in shades of gray. 
 
If you apply a background color to the chart, the note area does not use the same background color. 
You must also change the background color of the note. 
 
Steps 
 

1. Click the chart object. 
 

2. In the Color & Background section of the Properties pane, double-click the Palette property. 
 

3. In the Palette dialog box, click the new palette entry button to define a new palette entry: 
 

 To apply color, click Color, specify the color properties, and click OK. 
 

 To apply a gradient, click Gradient, specify the Direction, From color, and To color 
properties, and click OK. 

 

 To apply a pattern, click Pattern, specify the Pattern, Foreground color, and Background 
color properties, and click OK. 

 
 

Tip: You can also select a predefined palette from the Palettes box. 
 

4. Repeat step 3 for each chart series. 
 
 
Tips 

 To delete a palette definition, select the definition in the Palette box, and then click the delete button . 
 

 To change the order in which the colors, gradients, or patterns appear in the chart, use the arrow 
buttons under the Palette box to change their position. 

 

 To copy and paste a palette, open the palette dialog box and press Ctrl+c to copy the palette to the 
clipboard. Close the palette dialog box. Select another chart, open the palette dialog box, and press 
Ctrl+v to paste the palette from the clipboard. 

 
 
 
Example - Customize the Palette in the Order Trends Chart 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You have created 
a column chart that shows the contribution each order method makes to revenue. 
 
You decide to give each column a distinctive look to better differentiate the values of each order method 
for each year. 
 
Before you can try this example, you must create the chart in "Example - Create a Column Chart to Plot 
Order Trends".
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Steps 
 

1. Open the Order Trends chart. 
 

2. Click the chart object. 
 

3. In the Color & Background section of the Properties pane, double-click the Palette property. 
 

4. Click Color. 
 

5. On the Web Safe Colors tab, click a medium blue color and click OK. 

6. Click the new palette entry button , and then click Gradient. 
 

7. In the Direction box, click Top to Bottom. 
 

8. Click From color. 
 

9. On the Web Safe Colors tab, click a medium blue color and click OK. 
 

10. Click To color. 
 

11. On the Web Safe Colors tab, click a lighter blue color and click OK. 
 

12. Click the new palette entry button, and then click Pattern. 
 

13. In the Pattern box, click a diagonal line pattern. 
 

14. Click Foreground color. 
 

15. On the Web Safe Colors tab, click a blue color and click OK. 
 

Now you must add borders to the diagonal line pattern. 
 

16. Click the chart type icon in the Series drop zone. 
 

17. In the Properties pane, set the Borders property to Show. 
 

18. Save the chart. 

 
Change a Chart Background 
 

You can use a solid color, a pattern, or a gradient fill effect to customize the chart background. 
You can also use an image as a background for a chart. 
 
Steps 

1. Click the chart object. 
 

2. Click the unlock button , select the chart body by clicking between the axes, and, in the Properties 
pane, under Color & Background, double-click the Fill Effects property. 

 

3. In the Effect box, choose a color, a gradient fill effect, or a pattern: 
 To apply a color, click Color and specify the color properties. 
 To apply a gradient fill effect, click Gradient and then specify the Direction, From color, 

and To color properties. 
 To apply a pattern effect, click Pattern and specify the Pattern, Foreground Color, and 

Background Color properties. 
 

The foreground color is the color of the selected pattern. The background color is the color of 
the area behind the pattern. 
 

Tip: To remove a background fill effect, click None. 
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Add a Baseline to a Chart 
 

Baselines are horizontal or vertical lines that cut through the chart to indicate major divisions in the data. 
For example, you can add a baseline to show a sales quota or break-even point. 
 

You can position the baseline using the following options. 
 

 
 
If you apply more than one baseline, you can specify in which order they should be drawn when the report 
runs. They are drawn from top to bottom. If you have two baselines with the same coordinates, the first one 
in the list is drawn first and the next one is drawn on top of the first one. 
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Tip: The Positions to Fill sample report in the GO Data Warehouse (analysis) package includes a baseline.  
 
Steps 
 

1. Click the chart object. 
 

2. In the Chart Annotations section of the Properties pane, double-click the Baselines property. 
 

3. Click the new button   and choose the type of baseline from the list. 
 

4. Provide any necessary criteria, such as a value or percentage. 
 

5. If you add more than one baseline, specify their order using the up and down arrows. 
 

6. Click OK. 
 

A baseline icon appears in the Markers, notes, and baselines box. 
 

7. To define the line style, click the baseline icon  and set the Line Style property. 
 

8. To define the text style, click the baseline text and make changes in the Properties pane. 
 

Tip: To delete a baseline, click its baseline icon and click the delete button  . 

 
Example - Format the Axis Values of the Order Trends Chart 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You created a 
column chart that shows the contribution that each order method makes to revenue. 
 

You decide to format the y-axis values to make them easier to read. 
 
Steps 
 

1. Open the Order Trends chart. 
 

2. Select the y-axis. 
 

3. In the Data section of the Properties pane, double-click the Data Format property. 
 

4. Under Format type, click Number. 
 

5. Under Properties, in the Scale box, click -3, and click OK. 
 

6. Expand Axis titles. 
 

7. Select the y-axis title and, in the Properties pane, set the Default title property to No. 
 

8. Double-click the y-axis title and type 
 

Revenue (thousands) 
 

9. Save the chart. 
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Specify Custom Label Text 
 

You can override the default label properties. 
 

By default, chart labels use the name of the underlying data item label. You can change the label text to make 
it more meaningful. For example, you can rename a chart item labeled ISO_3_Letter_Code to Country. 
 
Steps 
 

1. Click the chart node member or measure. 
 

2. In the Chart Labels section of the Properties pane, set the Custom Label property to Show. 
 

A new chart text item appears. 
 

3. Do one of the following: 
 

 To change the text of the label, double-click the chart text item and type the text. 
 

 To change the source of the label text, select the new chart text item. In the Text Source 
section of the Properties pane, set the Source Type property. 

 
If nothing is specified in the new chart text item, the label appears blank. 
 
Tip: To remove a custom label, set the Custom Label property to Hide. 

 
 
 

Example - Show Values in the Chart Legend 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a chart that shows the quantity of items sold for each product line by order method. To 
show how much the quantity represents in revenue, you want to show the revenue for each order method in 
the legend. 
 
Steps 
 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 

2. In the Welcome dialog box, click Create a new report or template. 
 

3. In the New dialog box, click Chart and click OK. 
 

4. In the Chart group pane, click Column. 
 

5. In the Chart type pane, click Column. 
 

6. Click OK. 

7. In the Insertable Objects pane, on the Source tab , expand Sales and Marketing 
(query) and Sales (query). 

 

8. Expand Sales fact and drag Quantity to the Measure (y-axis) drop zone. 
 

9. Expand Order method and drag Order method to the Series drop zone. 
 

10. Expand Product and drag Product Line to the Categories (x-axis) drop zone. 
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11. From the Structure menu, clear Lock Page Objects . 
 

If you do not clear Lock Page Objects, you will be unable to insert a text item in the legend. 
 

12. In the Insertable Objects pane, on the Toolbox tab  , drag a text item to the legend 
next to Order method. 

 

 
 

13. In the Text box, type the following and click OK: 
 

- Revenue: 
 

You must insert a trailing space after the colon. 
 

14. In the Insertable Objects pane, on the Source tab, drag Revenue to the right of the text item. 
 

 
 

15. Run the report. 
 

The revenue is listed beside each legend item. 

Tip: To reposition the legend in the chart, click the legend icon , set the Absolute 
Position property to Yes, and specify the Left Position and Top Position values. 
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Example - Customize the Axis Titles 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a chart that shows the total revenue for the report in the horizontal axis title. 
 
Charts contain several titles, such as axis titles, report titles and subtitles, and the legend title. 
 
By default, the axis titles are managed for you. To customize an axis title, you drag text items or data items to 
the axis title area in the chart. You can use combinations of text, data items, and report expressions in titles. 
 
Tip: The Revenue by Date Range sample report in the Sales and Marketing (cube) package includes 
customized axis titles.  

 
Steps 

 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 
2. In the Welcome dialog box, click Create a new report or template. 

 

In the New dialog box, click Chart and click OK. 
 

3. In the Chart group pane, click Column. 
 

4. In the Chart type pane, click Column. 
 

5. Click OK. 

6. In the Insertable Objects pane, on the Source tab , expand Sales and Marketing 
(query) and Sales (query). 

 
7. Expand Sales fact and drag Revenue to the Measure (y-axis) drop zone. 

 
8. Expand Order method and drag Order method to the Series drop zone. 

 
9. Expand Product and drag Product line to the Categories (x-axis) drop zone. 

 
10. Expand Axis titles. 

 
11. Select the horizontal axis title. 

 

Tip: You can use the Properties pane to change the axis title properties, such as font & 
text, positioning, color & background, and so on. 

12. In the Insertable Objects pane, on the Toolbox tab  , drag a text item to the 
horizontal axis text. 

 
13. In the Text box, type the following and click OK: 

 
Product Line - Total Revenue: 

 
You must insert a trailing space after the colon. 
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14. In the Insertable Objects pane, on the Toolbox tab, drag a query calculation to the right 
of the text. 

 

 
 

15. In the Create Calculation dialog box, type the following and click OK: 
 

Total Revenue for Report 
 

16. In the Expression Definition box, type the following expression and click OK: 
 

total([Revenue] for report) 
 

17. Run the report. 
 
The title shows the calculated total revenue for Product line. 
 
Tip: You can use conditional formatting to conditionally style the titles. 
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Relational Reporting Style 
 

The relational reporting style is recommended for relational data sources. Relational data is best 
represented by lists. This data is organized in Report Studio by query items. 
 
In relational reporting, you summarize data by using headers and footers in lists, summary functions, 
member summaries, and within detail aggregation. You focus data in relational reporting with summary or 
detail filters. 

 
Add Relational Data to a Report 
 

Select the data items to appear in the report. 
 
We recommend using relational data in the relational reporting style. However, if you are using 
dimensional data, see "Add Dimensional Data to a Report". 
 
If you frequently use items from different query subjects or dimensions in the same reports, ask your 
modeler to organize these items into a folder or model query subject and then to republish the relevant 
package. For example, if you use the product code item in sales reports, the modeler can create a folder that 
contains the product code item and the sales items you need. 
 
 
Step 

 In the Insertable Objects pane, on the Source tab , drag each query item to the report. 
 

A flashing black bar indicates where you can drop an item. Items inserted in the report appear on the 

Data Items tab  . 

 
Tips 
 For more information about a query item, right-click the item in the Source tab and click Properties. 

For example, when working with relational data sources, the Usage property identifies the intended use 
for the data represented by the data item. You can also obtain more information by clicking Lineage. 

 
 Other ways to select data items are to double-click each item or to right-click each item and click Insert. 
 

 If you want to remove a data item from the report, select it and click the delete button  . To 
remove the data item from the report but keep it on the Data Items tab, click the cut button 
instead. 

 
 
Perform Advanced Grouping 
 

You can perform more advanced groupings in a list to get the results you want. For example, you can 
 

 view the entire grouping structure and make changes to the grouping order 
 

 group a data item that appears in a query but not in the layout 
 

 specify a list of properties for a group. 
 
You can also perform advanced sorting. 



 - 39 - 

Steps 
 

1. Click a column in the list. 
 
2. Click the select ancestor button  in the title bar of the Properties pane and click List. 

 
3. In the Properties pane, double-click the Grouping & Sorting property. 

 
4. To change the grouping order, in the Groups pane, click the grouped item in the Groups folder 

and drag it to the grouping hierarchy. 
 

5. To create a new grouping, in the Data Items pane, click the data item and drag it to the Groups 
folder in the Groups pane. 

 
6. To specify a list of data items for a group, do the following: 

 
 Click the group. 

 
Tip: Click Overall to specify a list of data items for the overall group. The overall group is 
the grouping of all data into one group. You can specify a list of data items for the overall 
group to add overall totals to the list. 

 

 Click the properties button  . 
 
 Select the appropriate check boxes. 

 
 
Divide Data into Sections 
 

Create sections in a report to show a data item as the heading of a section. When you run the report, 
separate sections appear for each value. 
 
Creating sections is similar to creating headers by grouping on a data item. The difference is that section 
headers appear outside the list, crosstab, chart, or repeater. In addition, you can group data items only in 
lists. 
 
When working with dimensional data, you can also create page layers to show values on a separate page for 
each member. 
 
Steps 

1. Click the column to make a section heading. 
 
2. Do one of the following: 

 From the Structure menu, click Section  . 
 

If the column is in a list or repeater, this menu option will create sections without creating a 
master detail relationship. This can improve performance when running the report. 

 
If the column is in a crosstab or chart, this menu option will create sections using a master 
detail relationship. 
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 From the Structure menu, click Section Using Master/Detail. 
 

This menu option creates sections using a master detail relationship. 
 

Sections are created, and a section header appears. The data container that contains the column 
used to create sections is embedded in a list. 

 
3. To add or remove section headers and footers, from the Structure menu, click Headers & Footers, 

click List Headers & Footers, and select or clear the appropriate check boxes. 
 

The section header and footer check boxes appear under Overall header. 

 
Remove Sections 
 

You can remove sections and reinsert the data item that was used to create the sections in the data container. 

 
Steps 

1. From the View menu, click Page Structure. 
 
2. Expand the page containing the data container with the section. 

 
3. Expand Page Body until you see the data container in which you added the section. 

 
The data container is nested in the List Column Body object of the List object that is created 
when you add a section. 
 

4. Drag the data container to Page Body. 
 

The data container appears as a node of Page Body. 
 

5. Delete the List object. 
 

6. From the View menu, click Page Design. 

7. In the Insertable Objects pane, click the Data Items tab  . 
 
8. Drag the data item that was used as a section header back into the data container. 

 
9. If you created sections in a list without creating a master detail relationship, click the data item, 

and then click the group/ungroup button  to ungroup the item. 
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Add a Simple Summary 
 

You can add simple summaries to the groups in a report by using the aggregate button. This button 
provides a subset of the aggregate functions available in Report Studio. For list reports, a Custom option is 
also available so that you can add your own aggregate function in the expression of the data item. 
 
The aggregate button sets the rollup aggregate property for the data item to the selected summary 
aggregate, and places the data item into an appropriate footer. A footer is created for each group as well as 
an overall footer, unless they already exist. 

 
Steps 

Click the column to which to add a summary. 
 
Click the aggregate button and click a summary type. 

 
To change the summary label, do the following: 

 
Click the label. 

 
In the Properties pane, under Text Source, set the Source Type property to the source type to 

define the label. 
 

For example, set it as Data Item Value to produce a dynamic label for the summary based on 
data item values. 

 
 Set the property below Source Type to specify the label. 
 

This property depends on the source type you chose. For example, if you chose Data Item 
Value as the source type, set the Data Item Value property to the data item to use to define 
the label. 
 

In lists, the summary appears as a footer. If the column to which you added a summary is grouped, group 
and overall summaries appear. In crosstabs and charts, the summary appears as a node. 

 
Tips 
 To change a summary, select it and, in the Properties pane, under Data Item, click Rollup Aggregate 

Function and choose a different function. 
 
 In crosstabs, you can add multiple summaries at the same level. For example, you have a crosstab with 

Product line as rows, Order year as columns, and Revenue as the measure. For Product line, you can 
add the Total summary as a header, which will total all revenue for each order year. You can then add 
the Average summary as a footer, which will give the average revenue of all product lines for each 
order year. 
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Sorting Relational Data 
 

You can sort items to view them in your preferred order. By default, Report Studio retrieves items in the 
order defined in the data source. OLAP data sources always have a defined order. Relational and 
dimensionally-modeled relational data sources may not always have a defined order. The data modeler 
defines the sorting options in the model. For more information about data modeling, see the Framework 
Manager User Guide. 
 
You can sort items in a list in ascending or descending order based on a value or a caption, such as revenue 
or employee name. You can also perform advanced sorting to sort columns within groups or to sort a row 
or column using another data item. 
 
Tip: The Sales Growth Year Over Year sample report in the GO Data Warehouse (analysis) package 
includes sorting. 
 
Steps 

1. Click the data item on which to sort. 
 

2. Click the sort button  and click Sort Ascending or Sort Descending. 
 

Tip: If you are sorting an extended data item, click the sort button, click Layout, and then click Sort 
Ascending or Sort Descending. 
 
An arrow appears beside the data item to indicate that a sort order was set. 
 
When you specify a sort order for more than one column, the columns are sorted in the order in which they 
were inserted in the report. For example, you add columns A, B, and C to a report and specify a sort order 
for each. When you run the report, column A is sorted first, then column B, and then column C. You can 
change the order in which the columns are sorted in the Advanced Sorting options. 
 
Tip: To remove a sort order, click Don't Sort. 

 
Perform Advanced Layout Sorting 
 

If you use relational data, in a list, you can sort columns within groups and change the sort order of 
columns. In a crosstab, you can sort a row or column by another item, such as Order year by Revenue. 
 
Steps to Sort in the Layout 

1. Click a column. 
 

In a crosstab, click the row or column on which to perform advanced sorting. 
 

2. From the Data menu, click Sort, and then click Advanced Sorting. 
 

Tip: If you are sorting a set, click Sort, click Layout, and then click Advanced Sorting. 
 

3. To sort a list column within a group, do the following: 
 

 In the Groups pane, under the Groups folder, expand the folder of the grouped column. 
 

 In the Data Items pane, drag the data items to sort to the Sort List folder. 
 

Tip: You can also drag data items from the Detail Sort List folder. 
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 Click the sort order button  to specify ascending or descending order. 
 

4. To change the sort order of columns, in the Groups pane, change the order of columns in the Sort 
List folder of a group or in the Detail Sort List folder. 
 
Tip: Add items to the Detail Sort List folder to sort items that are not groups. 
 

5. If you are sorting a crosstab, do the following: 
 

 From the Data Items pane, drag the item on which to sort to the Sort List pane. 
 

For example, you have a crosstab with Product line as rows, Order year as columns, and 
Revenue as the measure. To sort Order year by Revenue, drag Revenue to the Sort List pane. 
 

 Click the sort order button to specify ascending or descending order. 
 
 
Create a Master Detail Relationship 
 

Create a master detail relationship to deliver information that would otherwise require two or more reports. 
For example, you can combine a list with a chart. The list can contain product lines and the chart can show 
details for each product line. 
 
Master detail relationships must appear in nested frames to produce the correct results. You can create a 
master detail relationship in two ways: 
 

 Use a parent frame for the master query and a nested frame for the detail query. 
 

 Associate a report page with the master query and use a data container, such as a list or crosstab, for 
the detail query. 

 
You cannot display parent data in the child frame or child data in the parent frame. Also, you cannot 
perform calculations across master detail queries. 
 
You can use a master detail relationship to show data from separate data sources in a single report. 
However, the data sources must be contained in the same package. 
 
If you are working with an SAP BW data source, you cannot use a data item from the master query that 
contains non-ASCII values. 
 
To create a master detail relationship using queries that reference two different dimensional data sources, 
you must first link the members by aliasing the levels that contain the members. 
 
Steps 

1. To use a parent frame for the master query and a nested frame for the detail query: 
 

 In the Insertable Objects pane, on the Toolbox tab  , drag a List, Repeater Table, 
or Repeater to the report. 

 

 Add a second data container to the object you inserted. 
 

You can insert a list, crosstab, chart, repeater table, or repeater into a list. You can add a list to 
a repeater table or repeater. 
 

 Add data items to both data containers. 
 

2. To associate a report page with the master query and use a data container for the detail query: 
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 Click anywhere in the report page. 
 

 In the Properties pane, click the select ancestor button  and click Page. 
 

 Set the Query property. 
 

 In the Insertable Objects pane, on the Toolbox tab, drag a data container to the report. 
 

3. To link a data item in the master query to a parameter in the detail query instead of to another data 
item, create the parameter in the detail query. 

 

Use parameters to filter values at a lower level in the detail query. 
 

 Pause the pointer over the query explorer button  and click the detail query. 
 

 In the Insertable Objects pane, on the Toolbox tab, drag the Filter object to the Detail Filters box. 
 

 In the Expression Definition box, create the parameter. 
 

4. Pause the pointer over the page explorer button  and click the report page. 
 

5. Click anywhere in the report page. 
 

6. In the Properties pane, click the select ancestor button and click Page. 
 

7. Click the data container containing the details. 
 

8. From the Data menu, click Master Detail Relationships. 
 

9. Click New Link. 
 

10. In the Master box, click the data item that will provide the primary information. 
 

11. To link the master query to a data item, in the Detail box, click the data item that will provide the 
detailed information. 

 

12. To link the master query to a parameter, in the Parameters box, click the parameter that will 
provide the detailed information. 

 

Tip: To delete a link, select the link and press the Delete key. 
 

13. If your detail query object is a chart, you can disconnect a chart title from the master query. 
 

 Click the chart title, and then, from the Data menu, click Master Detail Relationships. 
 

 Clear the Use the master detail relationships from the chart check box. 
 

Tip: To avoid seeing the same data item twice in the report, click the data item in the data container 
driven by the detail query and click the cut button. This removes the item from the report display but 
keeps it in the query. 

 
Master Detail or Burst Reports with Charts or Crosstabs May Result in Denial of Service 
 

When running a master detail or burst report that includes a chart or crosstab, disk space exhaustion may 
cause the report or other requests to fail. A large set of burst keys or master rows may produce one or more 
charts per detail, resulting in many master detail executions. This may cause the temp folder to accumulate 
many gigabytes of temporary files containing data required for successful chart rendering. 
 
To avoid this issue, we recommend that you test large master detail or burst reports that include charts or 
crosstabs to determine the potential peak disk requirements for the report. 
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Using Relational Calculations 
 

Create calculations to make a report more meaningful by deriving additional information from the data 
source. For example, you create an invoice report and you want to see the total sale amount for each 
product ordered. Create a calculated column that multiplies the product price by the quantity ordered. 
 
For relational data sources, if an expression is used in multiple reports or by different report authors, ask 
your modeler to create the expression as a standalone object in the model and include it in the relevant 
package. For information about creating filters in the package, see the Framework Manager User Guide. 
 
You can add calculations to lists, crosstabs, and all other data containers. You can also add calculations 
directly to a page header, body, or footer. However, you must first associate a query to the page.  
 
Steps 
 

1. In the Insertable Objects pane, click the Toolbox tab . 
 
2. To create a calculation that will be applied to data, do the following: 

 
 Drag Query Calculation to the report. 

 
The Create Calculation dialog box appears. 
 
 In the Name box, type a name for the calculation. 

 
3. To create a calculation that contains run-time information, such as current date, current time, and 

user name, drag Layout Calculation to the report. 
 
4. In the Available Components box, define the calculation: 

 

 To add data items that are not shown in the report, on the Source tab  , double-click data 
items. 

 

 To add data items that are in the report but not necessarily in the model, such as calculations, 

on the Data Items tab  , double-click data items. 
 

 To add data items from a specific query, on the Queries tab  , double-click data items. 
 

 To add functions, summaries, and operators, on the Functions tab  , double-click 
elements. 

 

 To add a value that is derived from a parameter, on the Parameters tab  , double-click 
a parameter. 

 
Parameters define prompts, drill-through reports, and master detail relationships. 

 
Tip: You can also type the expression directly in the Expression Definition box. 

 

5. Click the validate expression button  . 
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Dimensional Reporting Style 
 

The dimensional reporting style is recommended for dimensionally-modeled relational (DMR) and Online 
Analytical Processing (OLAP) data sources. Dimensional data is best represented by crosstabs, maps, and 
charts. This data is shown in Report Studio in dimensions, hierarchies, levels, and members. 
 
In dimensional reporting, you summarize data by using member summaries and within set aggregation. 
You focus data in dimensional reporting by adding only the relevant members to the edge of a crosstab or 
to the context filter. You can also enable drilling up and drilling down in dimensional reports. 

 
Add Dimensional Data to a Report 
 

We recommend using dimensional data in the dimensional reporting style. However, if you are using 
relational data, see "Add Relational Data to a Report". 
 
If you are working with a dimensional data source, data items are organized hierarchically. 
Dimensional data sources include OLAP and dimensionally-modeled relational (DMR) data sources. 
 
The Source tab  in the Insertable Objects pane shows a metadata-based view of the data. 
 
 

 
 
 
Note: The names of levels and members in a dimension come from the model. It is the responsibility of the 
modeler to provide meaningful names. 
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1. Package 
Packages are subsets of a model containing items that you can insert in a report. 
 

2. Dimension 
Dimensions are broad groupings of descriptive data about a major aspect of a business, such as 
products, dates, or markets. 
 

3. Level hierarchy 
 

Level hierarchies are more specific groupings within a dimension. For example, for the Years 
dimension, data can be organized into smaller groups, such as Years, Current Month, and Last 
Month. 

 
4. Members folder 

 
Members folders contain the available members for a hierarchy or level. For example, the 
Members folder for the Years level hierarchy contains everything found in the Year, Quarter, 
and Month levels. 

 
Note: To see members folders, you must select the Show members folder check box in the Tools 
menu. 

 
5. Level 
 

Levels are positions within the dimensional hierarchy that contain information at the same order of 
detail and have attributes in common. Multiple levels can exist within a level hierarchy, beginning 
with a root level. For example, the Years level hierarchy has the following related levels. 

 
 

 
 

Tip: The Measures dimension contains the measures available in the data source. 
 

6. Member property 
 

Member properties are attributes that each member possesses. For example, gender could be a 
property for all employee members. 
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Insert Members 
 

By default, when you insert members from the source tree into your report, single members are inserted 
without any details or children. You can change how members are inserted. For example, you may want to 
insert a member along with all its children or insert only the member's children. 
 
When you double-click a member that you have already inserted in your report, by default, its children are 
inserted after the parent member. You can control whether the children are inserted before or after, nested, 
or not inserted at all: from the Tools menu, click Options, and then choose a setting on the Edit tab. 
 
When inserting members into a crosstab, ensure that you insert members from the same hierarchy only on 
one of the crosstab edges. If you insert members from the same hierarchy on both edges of the crosstab, 
you may encounter unexpected results. For example, a report that uses members from years in the rows and 
Quarters in the columns is very difficult to read because the useful numbers are distributed over a large area 
of mostly blank cells. 
 
Calculated members from the data source also appear in the source tree. However, calculated members in 
Microsoft SQL Server Analysis Services (SSAS) cubes do not appear in the list of descendants in the 
query. If you want these calculated members to appear in a report or a prompt, you must insert them 
explicitly. 
 
Steps 

1. Click the insert single member button  and select how to insert members. 
 

2. In the Insertable Objects pane, from the Source tab  , do one of the following: 
 

 To insert a member above or below another member, drag the new member above or below a 
cell. 

 
A flashing black bar appears where you can drop the new member. 
 

 
 

 To replace a member, drag the new member to the cell with the member to replace. 
 
A flashing black box appears where you can drop the new member. 
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Nest Members 
 

When you insert members in your report, you may want to nest them in another row or column to make 
your report easier to use. You can nest members from different dimensions. You can also nest sets. 
 
For example, in the following report, the quarters (Q1 to Q4) were selected from the Time dimension and 
nested only for the GO Americas member, which is from a different dimension. 
 

 
 
You can also double-click nested members to insert their children or you can expand them. 
 
When you filter out children from nested sets, the parent set still appears in your report. To avoid this, filter 
only the top level set and nest only the complete set of descendants at the desired levels. 
 
Step 
 

 In the Insertable Objects pane, on the Source tab  , drag the members to the work area. 
 

A flashing black bar indicates where you can drop an item. 

 
Search for Members 
 

You can perform a member search to quickly find data. 
 
You can control the number of members that are returned in a search by specifying a value for the  
Member display count limit (in source tree) option. 
 
Steps 

1. In the Insertable Objects pane, on the Source tab  , select and then right-click a dimension, 
hierarchy, or level and click Search. 

 
2. In the Words box, type the words or characters for which to search. 

 
3. Click the search parameter to use. 

 
4. To search all descendants instead of just the immediate children, select the Search all 

descendants check box. 
 

For example, when performing a search in a hierarchy, selecting this check box returns members 
found in all the levels of the hierarchy. 
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5. Click Search. 
 
Report Studio searches for all members for the object selected in step 1. The results appear in a 

hierarchical structure on the Search tab  in the Insertable Objects pane. You can browse the 
hierarchy to explore members at lower levels. 
 
Tip: You can insert members directly into a report. This can save you time, because you do not have to 
define a filter. For example, instead of inserting Product line from the Source tab and adding a filter 
for Camping Equipment, you can insert Camping Equipment from the Search tab. 

 
 
Add a Simple Summary 
 

You can add simple summaries in a report by using the aggregate button. This button provides a subset of 
the summary functions available in Report Studio. 
 
The aggregate button sets the rollup aggregate property for the data item to the selected summary 
aggregate, and places the data item into an appropriate footer. A footer is created for each set, hierarchy, or 
level. 
 
Steps 

1. Click the item to which to add a summary. 

2. Click the aggregate button  and click a summary type. 
 

3. To change the summary label, do the following: 
 

 Click the label. 
 

 In the Properties pane, under Text Source, set the Source Type property to the source type o 
define the label. 

 
For example, set it as Data Item Value to produce a dynamic label for the summary based on 
data item values. 

 
 Set the property below Source Type to specify the label. 

 
This property depends on the source type you chose. For example, if you chose Data Item Value 
as the source type, set the Data Item Value property to the data item to use to define the label. 

 
In crosstabs and charts, the summary appears as a node. 

 
Tips 
 To change a summary, select it and, in the Properties pane, under Data Item, click Rollup 

Aggregate Function and choose a different function. 
 
 In crosstabs, you can add multiple summaries at the same level. For example, you have a 

crosstab with Product line as rows, Order year as columns, and Revenue as the measure. For 
Product line, you can add the Total summary as a header, which will total all revenue for each 
order year. You can then add the Average summary as a footer, which will give the average 
revenue of all product lines for each order year. 
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Create a Context Filter 
 

When working with dimensional data, you can use context filters, or slicer filters, to quickly focus your 
report on a particular view of the data. 
 
For example, the following crosstab contains product lines in the rows, years in the columns, and revenue 
as the measure. We want to filter the values to show us the revenue for only Web orders from Asia Pacific. 
To change the context, you drag Asia Pacific and Web from the source tree to the Context filter section of 
the overview area. The crosstab then shows the revenue for only Asia Pacific and Web. Changing context 
changes only the values that appear. It does not limit or change the items in the rows or columns. 
 

 
 
The members that are used as the context filter appear in the report header when you run the report. 
 
Any summary values in the report are recomputed to reflect the results returned by the context filter. 
 
You can create multiple context filters to filter across two or more different hierarchies. 
 
Tip: The Budget vs. Actual sample report in the Sales and Marketing (cube) package includes a context filter.  
 
To use a calculation or expression to define a context filter, create a slicer member set using the query 
explorer. A slicer member set is an expression that returns a set of members from the same dimension. For 
example, you can define a slicer member set that filters for the top five products with the greatest revenue. 
 
Context filters are different from other filters. When you filter data, members that do not meet the filter 
criteria are removed from the report. A context filter does not remove members from a report. Instead, their 
values are filtered or and you see blank cells. 
 
You can also use context filters as prompts when the report is run. 
 
When creating context filters, 
 

  use only members from hierarchies that are not already projected on an edge of the crosstab 
 

 use only one member per hierarchy 
 
Steps to Create a Simple Context Filter 
 

1. In the Insertable Objects pane, from the Source tab  , select or search for one or 
more items on which to filter. 

 

2. Drag the item on which to filter into the Context filter section of the overview area. 
 

3. To change context, select a new item from the Context filter box. 
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Steps to Create an Advanced Slicer Filter 

1. Pause the pointer over the query explorer button  and click the query to which to add a 
slicer. 

2. On the Toolbox tab  , drag Slicer Member Set to the Slicer pane. 
 

3. Drag the members to the Expression Definition box. 
 

You must join the members in the expression by using the set function. For example, the following 
expression contains the Fax and Telephone members from the Order Method dimension: 
 

set([Fax],[Telephone]) 
 

4. To add members from another dimension, repeat step 2 to create a separate slicer member set. 
 

Sorting Dimensional Data 
 

You can sort items to view them in your preferred order. By default, Report Studio retrieves items in the 
order defined in the data source. OLAP data sources always have a defined order. Relational and 
dimensionally-modeled relational data sources may not always have a defined order. The data modeler 
defines the sorting options in the model. For more information about data modeling, see the Framework 
Manager User Guide. 
 

Tip: The Sales Growth Year Over Year sample report in the GO Data Warehouse (analysis) package 
includes sorting.  
 
Set Sorting 
 

You can sort sets of members based on their caption. By default, when you select Sort Set - Ascending or 
Sort Set - Descending, sets are sorted only by their captions. You can also perform advanced sorting to 
sort sets using an intersection (tuple) or a member property. 
 

For example, a set contains regions and you sort the regions within the set in descending alphabetical order. 
Only extended data items that represent sets support set sorting. 
 

Before you can perform set sorting, you must create sets for the members in your report. 
 

You cannot sort data items from different dimensions that are intermixed. For example, if you have years 
and products on the same edge and at the same level in your crosstab, you can sort the years, and you can 
sort the product lines, but you cannot sort them as combined set because years and products come from 
different dimensions. 
 
Sorting by Value 
 

You can sort members in the sets on the opposite axis based on the value of a member or measure that you 
select. 
 

For example, a crosstab contains years inserted as individual members in the columns, product lines 
inserted as a member set in the rows, and revenue as the measure. You select 2004, click the sort opposite 

axis sets by value button  , and sort in descending order. The values in the 2004 column are sorted. 
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Before you can perform this sorting, you must create sets for the members in your report. 
 
In nested crosstabs, items are sorted based on the values of the innermost nested row or column of the 
opposite axis. For example, a crosstab contains years in the columns and retailers nested within product line 
in the rows. Select 2004, sort in descending order, and you see retailers listed from the largest value to the 
smallest value for each product line. 
 
Steps to Sort Sets by Caption 
 

1. In a crosstab, select a set to sort. 
 

2. Click the sort button  and click Sort Set - Ascending or Sort Set - Descending. 
 

Tip: To remove a sort order, click Don't Sort. 
 

Steps to Sort Sets in the Opposite Axis by Value 
 

1. In a crosstab, select a member or measure to sort. 
 

For example, to sort a set in the row axis, select a member or measure in the column axis. 
 

2. Click the sort opposite axis sets by value button  . 
 

Tip: To remove a sort order, click Don't Sort. 
 
 
 
Create a Drill-up/Drill-down Report 
 
 

You can link groups of data items from different queries so that when you drill up or drill down in one 
query, the data item also drills up or drills down in the linked queries. Before you begin, ensure that you are 
using a dimensional data source. 
 
Tip: The Returned Items sample report in the GO Data Warehouse (analysis) package includes drilling.  
 
Steps 
 

1. From the Data menu, click Drill Behavior. 
 

2. On the Basic tab, in the Report output drill capabilities box, select the Allow drill-up and 
drilldown check box. 

 
By default, Report Studio determines which items can be drilled on based on the dimensional 
structure. 
 
Tip: To enable the report to be used as the source during a package drill-through, select the Allow 
this report to be a package-based drill-through source check box and click OK. For more 
information about package drill-through, see the Administration and Security Guide. 

 
3. To disable drill-up or drill-down for a data item, select the data item in either the Disable drillup 

for box or the Disable drill-down for box. 
 
4. From the Advanced tab, you can change the drill-up or drill-down behavior for any data item by 

selecting the data item and then choosing one of the following behaviors. 
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5. From the Data Items Linking tab, you can link groups of data items: 
 

 Click the new button  . 
 
 Type a name for this group of linked data items and click OK. 

To rename a group of linked data items, click the group, click the rename button  , type a 
name, and click OK. 
 

 Use the arrows to move data items from the queries on the left to the groups on the right. 
 

Note: You can only add a data item to one group. 
 
The report will generate links for any item that can be drilled up or down on. 

 
When you run a report, you can drill down or drill up by right-clicking the data item and 
choosing the action from the context menu. The menu items will be disabled if an item cannot 
be drilled up or down on. 

 
Recommendation - Drilling Down in Very Large Data Sources 
 

When you drill down in a report that uses a very large data sources query results can be much larger than 
what can be held in memory. For example, if you insert the lowest level of four hierarchies that each 
contain 1000 members, the report can contain 1000,000,000,000 cells. At best, this query will take a very 
long time to run. While this large query executes, all other queries for the same server process will likely be 
blocked. For most data sources, the query will likely fail due to insufficient memory or timing out. Then the 
memory is released and normal services resume. 
 
However, when using a Microsoft SQL Server 2005 Analysis Services (SSAS) cube, the memory 
consumed by the SSAS client is not always released in a way that other queries can effectively reuse. The 
server continues to run with insufficient memory, causing new queries to either run very slowly or fail 
completely. You may encounter an error, and, to continue, the system administrator must manually stop 
and restart the IBM Cognos 8 service. 
 
To avoid these problems, consider the size of hierarchy levels and sets when creating reports and avoid 
combining them in ways that create large queries. To determine the size of a set, create and run a very 
small report that includes only a count of the members within that set. You can also use filtering techniques 
to focus your data. 
 
Example - Create a Dashboard Report 
 

Create a dashboard report to show a high-level graphical view of company performance indicators. 
By using dashboards, users can 
 
 drill up and drill down to see higher and lower levels of detail 
 
 navigate to other targets, including Report Studio reports, Query Studio reports, and Analysis Studio 

analyses 
 
 include multiple charts derived from different data sources in a single report 
 
In this topic, you learn how to create a dashboard so that users can examine important sales data in a single 
view. 
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It should take 15 to 20 minutes to complete this topic, and your dashboard will look like this. 
 

 
 
Steps to Create the Report and Add Data 
 

1. Create a blank report with the GO Data Warehouse (analysis) package. 
 
2. Add a gauge chart, column chart, and crosstab. 

 
3. Drag the following items to the gauge chart: 

 
 Gross profit (in Sales fact) to the Default measure drop zone 
 
 Product line level (in Product) to the Needles (series) drop zone 

 
 Region level (in Retailer site) to the Gauges drop zone 

 
4. Drag the following items to the column chart: 
 

 Revenue (in Sales fact) to the Default measure (y-axis) drop zone 
 
 Product line level (in Product) to the Category (x-axis) drop zone 

 
 Retailer type level (in Retailer) and Region (in Retailer site) to the Series drop zone 
 

5. Drag the following items to the crosstab: 
 

 Gross margin (in Sales fact) to the Measures drop zone 
 
 Product line level (in Product) to the Rows drop zone 

 
 Year level (in Time dimension) and Region level (in Retailer site) to the Columns drop zone 
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Steps to Format the Gauge Chart 
 

1. Click the gauge chart. 
 

2. Set the Size & Overflow property width to 400 px. 
 

3. Set the Title property to Show. 
 

4. Double-click the chart title and type the following text: 
 

Gross Profit for Product Lines by Region 
 

5. Set the Font property for the chart title to Arial, 12pt, Bold. 
 
6. Expand Axis titles, click the horizontal axis title, and set the Visible property to No. 

 
7. Click the numerical axis and, in the Maximum Value property, type 4000000. 

 
Steps to Format the Column Chart 
 

1. Click the Region series and set the Chart Type property to Line. 
 

Note: The column chart becomes a combination chart because you render the sales territory data as lines. 
 

2. Click the chart, click the Palette property, and select Contemporary from the Palette list. 
 
3. Set the Size & Overflow property width to 600 px. 

 
4. Set the Title property to Show. 

 
5. Double-click the chart title and type the following text: 

 
Product Lines: Revenue by Retailer Type and Region 
 

6. Set the Font property for the chart title to Arial, 12pt, Bold. 
 
7. Expand Axis titles, click the horizontal axis title, and set the Visible property to No. 
 

Steps to Specify the Drill Behavior 
 

1. From the Data menu, click Drill Behavior. 
 
2. Select the Allow drill-up and drill-down check box. 

 
3. Run the dashboard to view what it will look like for your users. 
 

Users can drill up or drill down on values in the report to view related information. 
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Browse or Search the Values of a Data Item 
 

When building expressions in the expression editor, you can browse the data of a data item. This is useful 
when you do not know how a particular value is stored in the database. For example, you want to filter a 
report so that it shows data for only China. The actual value in the database for China is The People's 
Republic of China, and this is what you must insert in the filter expression to obtain the correct results. 
 
You can also browse the data of a data item when creating conditional styles. 
 
Steps 
 

In the source, data items, or query tab, right-click the data item you want to browse. 
 
If you want to insert a single value, click Select Value. 

 

If you want to insert multiple values, click Select Multiple Values  . 
 

In the Values box, click the value you want to insert in the expression. 
 

Tip: Use the Words box to search for specific values. If the data source is case sensitive and you 
want to perform a case insensitive search, click the Search arrow and then click Case Insensitive. 
 

If you clicked multiple values, click the right arrow button  to add them to the Selected values 
box. 

 
Click Insert. 

 
Tip: To control where values appear in the Expression Definition box, you can click the copy 

button if you selected a single value  or the copy all button if you selected multiple values 
instead. The values are copied to the clipboard, and you can then paste them where you want. 
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Adding Prompts to Filter Data 
 

You can add prompts to a report to add interactivity for users. Prompts act as questions that help users to 
customize the information in a report to suit their own needs. For example, you create a prompt so that 
users can select a product type. Only products belonging to the selected product type are retrieved and 
shown in the report. 
 
Prompts are composed of three interrelated components: parameters, prompt controls, and parameter 
values. Parameters are based on parameterized filters and form the questions to ask users. Prompt controls 
provide the user interface in which the questions are asked. Parameter values provide the answers to the 
questions.  
 
Report Studio provides several ways to create prompts. You can 
 

 use the Build Prompt Page tool 
 

 build your own prompt and prompt page 
 

 create a parameter to produce a prompt 
 

 insert prompts directly into the report page 
 

 in dimensional reporting, you can also define prompts using context filters. 
 
If you include reports from different packages in an interactive dashboard that uses global filters, ensure 
that you use the same parameter name for the prompt in all the reports. For more information about creating 
interactive dashboards, see the Administration and Security Guide. 
 
You can also create prompts in the package. For more information, see the Framework Manager User 
Guide. 
 
Syntax of Prompt Expressions 
 

Prompt expressions use the following syntax, where p represents the parameter name. 
 

 
 
Use the Build Prompt Page Tool 
 

Use the Build Prompt Page tool to quickly add prompts to a report. Report Studio creates the prompts for 
you in a default prompt page. 
 
Tips: The Promotion Success sample report in the GO Data Warehouse (analysis) package includes a 
prompt page. The Historical Revenue sample report in the Sales and Marketing (cube) package and the 
Eyewear Revenue by Brand and Size sample report in the GO Data Warehouse (analysis) package include 
multiple prompts. 
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Steps 
 

1. Click the column on which users will be prompted. 
 

To create multiple prompts or a cascading prompt, click more than one column. 
 

2. From the Tools menu, click Build Prompt Page. 
 

A prompt page is created that has 
1.  

 a page header 
 
 a prompt control for each selected column 
 
 a page footer containing Cancel, Back, Next, and Finish buttons 
 

You can add more objects or modify existing elements. For example, you can change the 
prompt control chosen by Report Studio. 

 
Build Your Own Prompt and Prompt Page 
 

Create your own prompt and prompt page to control how they appear in a report. 
 
Tip: The Promotion Success sample report in the GO Data Warehouse (analysis) package includes a 
prompt page.  
 
Steps 

1. Pause the pointer over the page explorer button  and click Prompt Pages. 
 

2. In the Insertable Objects pane, on the Toolbox tab, drag Page to the Prompt Pages box. 
 

3. Double-click the page you just created. 

4. In the Insertable Objects pane, on the Toolbox tab  , drag one of the following prompt 
controls to the prompt page. 
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. 
The Prompt Wizard dialog box appears. 
 

5. If you are creating a text box, date, time, date and time, interval, or generated prompt, do the 
following: 

 

 Create a new parameter for the prompt or use an existing parameter. 
 

 Click Next. 
 

 If you create a new parameter, define the expression by selecting a data item from the package 
and the operator to use. 

 

Tip: Make the prompt optional by selecting the Make the filter optional check box. 
 

 Go to step 7. 
 

6. If you are creating a value, select & search, or tree prompt, do the following: 
 

 Create a new parameter for the prompt or use an existing parameter. 
 

 Click Next. 
 

 If you created a new parameter and you want to use the parameter to filter data, select the 
Create a parameterized filter check box and define the expression by selecting a data item 
from the package and the operator to use. 
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If you are creating a tree prompt, you must choose in in the Operator box. 
 
You can also use a parameter to provide a value for a layout calculation, such as showing a 
user's name in the report. When the report is run, you can use a parameter to prompt the user 
to type his name and have it appear in the report. 
 
Tip: Make the prompt optional by selecting the Make the filter optional check box. 

 
 Click Next. 
 
 If you created a parameterized filter and you have more than one query defined in the report, 

select the check box for the query on which to filter and click Next. 
 

 Select the Create new query check box to create the query that will be used to build the list 
of data values shown when the report is run. 

 
Tip: Do not create a new query if you want to link the prompt to an existing query or if you 
intend to create the query at a later time. 

 
 Click the ellipsis (...) button beside Values to use and click the data item on which to prompt. 
 
 To choose a data item that is different than what users will see when they are prompted, click 

the ellipsis (...) button beside Values to display and click the data item. 
 

 To create a cascading prompt, in the Cascading source box, click the parameter that 
represents the cascade source. 

 
7. Click Finish. 
 
The prompt control is added to the prompt page. A prompt page is like a report page. You can insert 
graphics and text and apply formatting. 
 
You can also modify the properties of the prompt control by clicking it and making changes in the 
Properties pane. 

 
 
Example - Create a Report Showing Products Shipped for a Specific Time Interval 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a report that shows the time interval between closing and shipping dates. 
 
Steps 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 
2. In the Welcome dialog box, click Create a new report or template. 

 
3. In the New dialog box, click List and click OK. 

 

4. In the Insertable Objects pane, on the Source tab  , expand Sales and Marketing (query) 
and Sales (query). 

 
5. Expand Sales order and double-click Order number. 
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6. Expand Product and double-click Product name. 

 
7. Expand Sales fact and double-click Quantity. 
 

8. In the Insertable Objects pane, on the Toolbox tab  , drag Query Calculation to the right 
of Return quantity in the list. 

 
9. In the Name box, type the following and click OK: 

 

Time Interval 
 

10. In the Expression Definition box, type the following and click OK: 
 

[Sales (query)].[Time dimension (close day)].[Date (close day)]-[Sales (query)].[Time (ship 
date)].[Date (ship date)] 
 

11. From the Data menu, click Filters  . 
 

12. Click the add button  . 
 

13. In the Expression Definition box, type 
 

[Sales (query)].[Time dimension (close day)].[Date (close day)]-[Sales (query)].[Time (ship 
date)].[Date (ship date)] > ?p1? 
 

14. Click OK twice. 
 

A parameterized filter is created that will return data when the difference between the return date 
and the order date is greater than the value specified by the user. 
 

15. Pause the pointer over the page explorer button  and click Prompt Pages. 
 
16. In the Insertable Objects pane, drag Page to the Prompt Pages pane, and then double-click it. 

 
17. In the Insertable Objects pane, on the Toolbox tab, drag Interval Prompt to the work area. 

 
The Prompt Wizard dialog box appears. 
 

18. Click Use existing parameter, and then click p1. 
 
19. Click Finish. 

 
20. Run the report. 

 
An interval prompt appears. 
 

21. In the Days box, type a value and click Finish. 
 

Tip: You can also type values for the Hrs and Mins boxes. 
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A list report appears showing all products that were shipped after the time interval you specified. 
For example, if you typed 5, the list will show products that were shipped more than 5 days after the 
order date. 

 

 
 
Create a Parameter to Produce a Prompt 
Report Studio can automatically generate prompted reports based on parameters you create. When you run 
the report, Report Studio can generate a prompt page for each parameter not associated to an existing 
prompt page depending on whether the prompt run option is selected or not. 
 

You can also define parameters when you want to create a drill-through report or define master detail 
relationships. 
 
Steps 

1. From the Data menu, click Filters  . 
 

2. On the Detail Filters tab, click the add button  . 
 

The Detail Filter dialog box appears. 
 

3. In the Available Components box, click the Source tab  or the Data Items tab  to 
select the data item to use for the prompt: 

 

 To filter data based on data items not shown in the report, double-click a data item on the Source 
tab. 
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 To filter data that appears in the report but not necessarily in the model, such as calculations, 

double-click a data item on the Data Items tab. 
 

The data item appears in the Expression Definition box. 
 
4. In the Expression Definition box, type an operator after the data item or select an operator from 

the Functions tab  . 
 

The operator sets some of the default properties of the prompt. For example, if the operator is 
equals (=), users will be able to select only a single prompt value and the prompt's Multi-Select 
property is set to No.  

 
5. Type a name after the operator to define the prompt parameter. A question mark must precede and 

follow the name. 
 
6. To specify whether the prompt is mandatory, in the Usage box, click Required, Optional, or 

Disabled. 
 
Create a Prompt Directly in a Report Page 
 

You can add prompt controls directly in a report page instead of creating a prompt page. 
 
Prompt controls that are added to report pages will not appear in the following: 
 

saved reports 
 

PDF reports 
 

reports that are sent to users by email 
 

scheduled reports 
 
Prompt controls are interactive. They are used to satisfy parameter values before running a report. As a 
result, prompt controls added to a report page only appear when you run the report in HTML format. When 
you run a report in HTML format, users select which values they want to see, and the report is refreshed, 
producing a new report. 
 
For the non-interactive reports listed above, prompt parameter values must be collected and satisfied before 
the report is run. You provide the parameter values using the Run options tab in IBM Cognos Connection. 
If you do not provide all the required values, the report will fail to run.  

You can access the Run options tab by clicking the set properties button  for the report. 
  
Tip: The Revenue by Product Brand (2005) sample report in the Sales and Marketing (cube) package and 
the Rolling and Moving Averages interactive sample report include value prompts. 
 
Steps 

1. In the Insertable Objects pane, on the Toolbox tab  , drag a prompt control to the report. 
The Prompt Wizard dialog box appears. 

 
2. Provide the information necessary to create the prompt. 
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Tip: Make the prompt optional by selecting the Make the filter optional check box. Otherwise, 
when you run the report for the first time, the prompt appears in a generated prompt page rather 
than in the report page. Alternatively, you can specify a default selection for the prompt. 
 

3. In the work area, click the prompt. 
 
4. In the Properties pane, set the Auto-Submit property to Yes. 

 
If you do not set the Auto-Submit property to Yes, the report will not refresh when users select a 
different prompt value. 
 

Tip: An alternative to setting the prompt to auto-submit is to add a prompt button from the 
Toolbox tab and set its Type property to Finish. 

 
The prompt control is added to the report page. You can modify its properties by clicking it and 
making changes in the Properties pane. 
 

 
Change the Prompt Control Interface 
 

By default, when you create a prompt, Report Studio selects the prompt control interface. You can change 
the prompt control interface depending on the type of prompt you created. For example, for a value prompt, 
you can choose a drop-down list, a list box, or a radio button group. 
 
Steps 
 

1. Click the prompt control. 
 

2. In the Properties pane, set the Select UI property to the interface. 
 

Specify That a Prompt Requires User Input 
 

You can specify that a prompt requires user input before the report can run. 
 
Steps 
 

1. Click the prompt control. 
 
2. In the Properties pane, set the Required property to Yes. 

 

3. Pause the pointer over the page explorer button  and click a report page. 
 

4. From the Data menu, click Filters  . 
 

5. Click the filter associated with the prompt. 
 

6. In the Usage box, click Required. 
 

When you run the report, a star appears next to the prompt indicating that the user must select or type a 
value. 
 
If you have a cascading prompt and the parent prompt control is required, the child prompt control is 
disabled. This ensures that users choose at least one value in the parent prompt before they can choose 
a value in the child prompt. Conversely, if the parent control is optional, then the child control is 
populated. This gives users the ability to choose values in the child prompt without having to choose a 
value in the parent prompt. 
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Allow Users to Select Multiple Values in a Prompt 
 

You can allow users to select more than one value in a prompt. For example, you have a prompt for which 
users must select a product line. You can modify the prompt so that users can select more than one product 
line. 
 
If you enable multiple selections, the Auto-Submit property is always set to no. 
 
Steps 
 

1. Click the prompt control. 
 
2. In the Properties pane, choose whether to allow users to specify more than one value or a range of 

values: 
 

 To allow users to specify more than one value, set the Multi-Select property to Yes. 
 

 To allow users to specify a range of values, set the Range property to Yes. 
 

3. Pause the pointer over the page explorer button  and click a report page. 
 

4. From the Data menu, click Filters  . 
 

If you have more than one query defined in the report, you must first click an object linked to a query. 
 

5. Double-click the filter associated with the prompt. 
 

6. Change the operator to one of the following: 
 

 If you are creating a multi-select prompt, change the operator to in. 
 

For example, [Product_line] in ?Product line? where [Product_Line] is the name of the data 
item allows users to select multiple product lines. 
 

 If you are creating a range prompt, change the operator to in_range. 
 

For example, [Margin] in_range ?Margin? where [Margin] is the name of the data item allows 
users to specify a margin range. 

 
 
Specify Prompt Values 
 

Provide your own values in a prompt to 
 

 show something different from what is in the database 
 

 improve performance by not accessing the database 
 

 provide text for optional prompts, such as Select a value 
 

 restrict the number of values available 
 
For example, you have a prompt in which users choose a country. For the database value United States, you 
want USA to appear in the prompt. 
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Tip: The Rolling and Moving Averages interactive sample report includes a value prompt. 
 
Steps 
 

1. Click the prompt control. 
 
2. In the Properties pane, double-click the Static Choices property. 

 

3. Click the add button  . 
 

4. In the Use box, type the prompt value to add. 
 

5. In the Display box, type the value that will appear in the prompt. 
 

6. Repeat steps 3 to 5 to add other prompt values. 
 

7. To link a prompt value to a condition, do the following: 
 

 In the Variable box, choose the variable to use or create your own. 
 

 In the Value box, click one of the possible values for the variable. 

 Click the static value to link to the variable and click the edit button  . 
 

 In the Display box, type the value to appear in the prompt. 
 

 Repeat this procedure for each additional value. 

 
Add a Prompt Button 
 

Add prompt buttons so that users can submit selected items, cancel reports, or navigate between pages. 
 
When you are building prompts and prompt pages, you may have to add prompt buttons to submit 
selections. Some prompt controls, such as the value prompt, can be set to submit selections automatically. 
Other prompt controls, such as the date prompt, require a prompt button. 

 
Steps 

1. Pause the pointer over the page explorer button  and click the page to which to add a prompt 
button. 

2. In the Insertable Objects pane, on the Toolbox tab, drag Prompt Button  to the work area. 
 

3. Click the prompt button and, in the Properties pane, set the Type property to one of the following 
actions. 
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Create a Cascading Prompt 
 

Create a cascading prompt to use values from one prompt to filter values in another prompt. For example, a 
report contains the columns Product line and Product type. You create prompts for these columns, and you 
specify that the Product type prompt is a cascading prompt that uses Product line as the source. When users 
select a product line, they see only the product types related to the selected product line. 
 
Tip: The Employee Training by Year sample report in the GO Data Warehouse (analysis) package includes 
cascading prompts.  
 
Steps 

1. To make the cascading source a required prompt, select it and, in the Properties pane, set the 
Required property to Yes. 

 
2. Click the prompt control to use as a cascading prompt. 

 
3. In the Properties pane, double-click the Cascade Source property. 

 
4. Click the parameter that represents the cascade source. 

 
5. If the prompt allows users to select multiple values, add a prompt button to the cascade source to 

provide the cascading prompt with the appropriate values: 
 

 In the Insertable Objects pane, on the Toolbox tab, drag Prompt Button  to the report. 
 

 Click the prompt button and, in the Properties pane, set the Type property to Reprompt. 
 

 To change the text in the prompt button, in the Insertable Objects pane, on the Toolbox tab, 

drag Text Item  to the prompt button and type the text. 
 

For more information about how to create cascading prompts, see the Report Studio Quick Tour. 
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Laying Out a Report 
When creating a report, a good layout is essential to ensure that the information in the report is presented in 
a clear and effective manner. 
 

The Page Structure View 
When you add objects to a report, you usually work in the layout. From the View menu, click Page 
Structure to view the report in a different way. 
 

 
 
Use the page structure view 
 
 to view the entire contents of a report page in a tree structure Using a tree structure is useful for 

locating the objects in a page and troubleshooting problems with nested objects. 
 

 to quickly move objects from one area of a page to another 
 

If you have a complex layout, it may be difficult to select, cut, and paste objects in the layout view. 
Objects are easier to locate in the page structure view. 

 
 to modify object properties 
 
You can modify object properties in the layout or in the page structure view. 
 
Tip: To switch back to the report layout, from the View menu, click Page Design. 

 
Copy Object Formatting 
 

You can quickly copy the formatting of items in your report, such as fonts, colors, borders, and number 
formats, and apply that formatting to other items. 
 
Steps 
 

1. Click an item that has the formatting to copy. 
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2. Do one of the following: 

 To copy all the formatting applied to the item, click the pick up style button  , click the 

item to format, and then click the apply style button  . 
 

 To copy only one of the formatting styles, click the down arrow to the right of the pick up 
style button and click the style to copy. Then click the item to format and click the apply style 
button. 

 

3. If you want to make changes to a style that you copied, click the down arrow to the right of the 
pick up style button and click Edit Dropper Style. 

 

4. In the Style dialog box, specify basic and advanced style characteristics. 
 
Add a Header or Footer to a Report 
 

Add a header or footer to make a report easier to read. Headers and footers are containers in which you can 
add objects like text, images, and report expressions such as the current date and page numbers. You can 
add headers and footers to pages and lists. 
 

Tip: The Revenue by Product Brand (2005) sample report in the Sales and Marketing (cube) package 
includes a customized header and footer.  
 

Pages 
Add a page header or footer when you want information to appear on every page in the report, such as a 
title or page numbers. 
 

Lists 
You can add the following headers and footers to lists to organize data into logical sections or to identify 
every change in value of a column. 
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You can also add section footers by adding a summary. 
 

To see the headers and footers, ensure that the visual aids are turned on. 
 
Steps 
 

1. If you want to add a page header or footer, from the Structure menu, click Headers & Footers, 
Page Header & Footer, select the appropriate check boxes, and click OK. 

 

Tip: You can also click the headers & footers button  on the toolbar. 
 

2. If you want to add a list header or footer, from the Structure menu, click Headers & Footers, 
List Headers & Footers, select the appropriate check boxes, and click OK. 

 

Tip: You can also click the headers & footers button on the toolbar and then click the list headers 

& footers button . 
 

3. If you want to add objects to a header or footer, drag the objects from the Insertable Objects pane 
to the appropriate location. 

 
To add objects to a list header or footer, you must first unlock the report. From the Structure 

menu, click Lock Page Objects  . 
 

Tip: To add data items to the page header or footer, you must associate a query to the page. 
 

4. To split a header or footer into multiple cells that span the list, from the Structure menu, click 
Headers & Footers and click Split List Row Cell. 

 

5. To merge multiple cells in a header or footer, from the Structure menu, click Headers&Footers 
and click Merge List Row Cells. 

 

6. To add rows to a header or footer, from the Structure menu, click Headers&Footers and click 
Insert List Row Cells Above or Insert List Row Cells Below. 

 
Add Borders to an Object 
You can add borders to objects in a report such as a column, a header, or a footer or to the whole report. 
 
Steps 
 

1. Click the object to which to add a border. 
 

Tip: To quickly select the parent of an object, click the object, and then click the select ancestor 
button  in the title bar of the Properties pane. 
 

2. In the Properties pane, double-click the Border property and select values in the Color, Style, 
and Width boxes. 

 

Note: Specifying a width using % as the unit of measure is not supported when producing reports 
in PDF. 
 

3. Apply the selected values to the top, bottom, left side, right side, or all sides of the object by 
clicking the appropriate button in the Preview section. 

Tip: To clear the border applied, click the clear borders button  . 
 

Tip: You can also add borders using the Report Studio toolbar. 
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Add a Text Item to a Report 
You can add text to a report. You can insert text in other objects, such as a block or table cell, or directly in 
the report page. 
 
You can also add multilingual text to a report. 
 
Steps 
 

1. In the Insertable Objects pane, click the Toolbox tab. 
 

2. Drag the Text Item object  to the report. 
 

The Text dialog box appears. 
 

3. Type the text and click OK. 
 

Tip: You can also paste text from another part of the report. 
 
If you click OK without typing any text, Report Studio inserts the string Double click to edit text. 
 

You can now format the text by changing the font, color, size, and so on. Select the text and make the 
appropriate changes in the Properties pane. 

 
 

Insert an Image in a Report 
 

You can insert an image in a report. You can insert images in other objects, such as blocks or table cells, 
directly in the report page or as the background image of another object. 
 
The images that you insert must first be uploaded to the IBM Cognos 8 server or another Web server and 
must be .gif or .jpg format. 
 
Steps 

1. In the Insertable Objects pane, click the Toolbox tab  . 
 

2. Drag the Image object  to the report and then double-click it. 
 

3. In the Image URL dialog box, type the URL of the image to insert or click Browse to go to the 
location containing the image. 

 
To browse images on a Web server, you must enable Web-based Distributed Authoring and 
Versioning (WebDAV) on your Web server. For more information about configuring Web servers, 
see the Installation and Configuration Guide. 

 
Insert a Background Image in an Object 
 

You can insert a background image for objects in a report. For example, use a background image to add a 
watermark to a page. 
 
You can also create your own background visual effects, such as drop shadows and gradient fills. 
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The images that you insert must first be uploaded to the IBM Cognos 8 server or another Web server and 
must be .gif or .jpg format. 
 
Steps 
 

1. Select the object. 
 
2. In the Properties pane, double-click the Background Image property. 

 
3. In the Image URL box, type the URL of the image to insert or click Browse to go to the 

location containing the image. 
 

To browse images on a Web server, you must enable Web-based Distributed Authoring 
and Versioning (WebDAV) on your Web server. For more information about configuring 
Web servers, see the Installation and Configuration Guide. 
 
Tip: To remove an image, delete the URL. 
 

4. In the Position box, choose how to align the image in the object. 
 
5. In the Tiling box, click a tiling option. 

 
 
 

Show Data for Specific Time Periods 
 

Show data for a specific time period to associate a report with a business time period rather than the 
execution time. For example, you have a monthly report that you run at the beginning of each month, and 
you want the last business day of the previous month to appear rather than the day on which you run the 
report. 
 
If the report functions AsOfDate() and AsOfTime() are added to the report, they will return a value based 
on the results of the As of Time Expression object. If the As of Time Expression object is not added to 
the report, these two functions return the date and time at which the report is run. 
 
If the As of Time Expression object is added more than once in the report, the first occurrence of the 
object in the layout that returns a valid value is used. 
 
Steps 

1. In the Insertable Objects pane, on the Toolbox tab  , drag As of Time Expression to the 
report. 

 
2. Double-click As of Time Expression. 

 
3. In the Expression Definition box, type the expression. 

 
The expression must return a date-time value. 
 
Tip: You can drag a function that returns a constant from the Constants folder in the Functions 
tab. You can then change the constant to the value to use. 
 
If you do not specify a time, the default time 12:00:00.000 AM is used. 
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Align an Object in a Report 
 

You can specify a horizontal and vertical alignment for an object in a report to determine where they 
appear. 
 
Tables can also be used to determine where objects appear in a report. 
 
Note: The Justify horizontal alignment works with HTML output but does not apply to PDF output. 
 
Steps 
 

1. Select the object to align. 
 
2. From the toolbar, click one of the available horizontal or vertical alignment buttons. 

 
Use a Table to Control Where Objects Appear 
 

You can use tables in your report to control where objects appear. Tables can be inserted anywhere in a 
report, such as a header, a footer, or the page body. After you create a table, insert objects in the cells. 
 
You can also apply a predefined table style to tables. 
 
The alignment buttons can also be used to determine where objects appear in a report. 
 
Tip: The Singletons on Page Body sample report (p. 541) in the GO Sales (analysis) package includes a 
table to control the report layout. 
 
Steps 
 

1. In the Insertable Objects pane, click the Toolbox tab. 
 

2. Drag Table  to the report. 
 

The Insert Table dialog box appears. 
 

3. In the Number of columns and Number of rows boxes, type the number of columns and rows for 
the table. 

 
4. If you want to have the table span the width of the report page, select the Maximize width check box. 

 
5. If you want to add borders to the table, select the Show borders check box. 
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Add Multiple Items to a Single Column 
 

You can add multiple items to a single column to condense a report. For example, you have a list report 
that contains many columns. You can reduce the number of columns in the list by putting related 
information in a single column. 
 
Steps 
 

From the Structure menu, click Lock Page Objects to unlock the report. 
 
In the Insertable Objects pane, drag the items to the column. 
 

For example, you can add data items from the Source tab  or text items from the Toolbox tab  . 

 
Example - Create a Report with Multiple Items in One Column 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a list report showing the name, position, email address, phone number, extension, and 
fax number for each sales representative in each city organized by country. To reduce the number of 
columns in the list, you show email addresses, phone numbers, extensions, and fax numbers in a single 
column. 
 
Steps to Create a List Report 
 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 

2. In the Welcome dialog box, click Create a new report or template. 
 

3. In the New dialog box, click List and click OK. 

4. In the Insertable Objects pane, on the Source tab  , expand HR (query), Employee 
summary (query), and Employee by region. Add the following data items to the list by double-
clicking them: 

 

 Country 
 

 City 
 

 Employee name 
 

 Position name 
 

 Email 
 

 Work phone 
 

 Extension 
 

 Fax 
 

5. Click the Country column and, from the Structure menu, click Section  . 
 

6. From the Structure menu, ensure that the report is unlocked. 
 

7. Click Country and, in the Properties pane, double-click the Font property. 
 

8. Change the font to Arial Black, 11 pt, and Bold, and then click OK. 
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Steps to Combine Items in One Column 

1. In the Insertable Objects pane, on the Toolbox tab  , drag Table to the right of the Work phone 
text item in the first row of Work phone column and create a table that has one column and three 
rows. 

 
2. Drag the following data items to the table: 

 

 Email to the first row 
 

 Work phone to the second row 
 

 Fax to the third row 
 

3. Drag Extension to the right of Work phone in the table. 
 
4. In the Insertable Objects pane, on the Toolbox tab, drag Text Item to the left of each item in the 

table and type the following for each item, putting a blank space before and after the text: 
 

 Email: 
 

 Work phone: 
 

 ext: 
 

 Fax: 
 

5. Ctrl+click the Extension, Email, and Fax column titles and click the delete button  . 
 
6. Click the Work phone column title. 

 
7. In the Properties pane, click the Source Type property and click Text. 

 
8. Double-click the Text property. 

 
9. Type the following and click OK: 

 
Contact Information 

 
10. Select the Work phone data item in the first row of the list above the table and click the 
 

 delete button  . 
 
11. Double-click the text item in the page header, type the following, and click OK: 

 
Sales Representatives Contact List 

 
12. From the Structure menu, click Lock Page Objects. 

 
The report is locked. 

 
13. Run the report.
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Contact information for each sales representative appears in a single column. 
 

 
 
Reuse a Layout Object 
 

You can save time by reusing layout objects that you add to a report instead of re-creating them. 
For example, you have a multiple-page report and you want to show the company logo in the page header 
of each page. Insert the logo once and reuse it on all other pages. 
 
Steps 
 

1. Click the object to reuse. 
 

Tip: To quickly select the parent of an object, click the object, and then click the select ancestor 

button  in the title bar of the Properties pane. 
 

2. In the Properties pane, set the Name property to a value beginning with a letter to uniquely 
identify the object and press the Enter key. 

 
Report Studio may have already specified a name for the object. 
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3. To reuse the object in another report, open that report. 
 

4. In the Insertable Objects pane, on the Toolbox tab  , drag the Layout Component 
Reference object to the location in which it will be reused. 

 
5. In the Component Location box, do one of the following: 

 
 To reference an object in the current report, click This report. 
 
 To reference an object in another report, click Another report, click the ellipsis (...) button, and 

open the report. 
 

6. In the Available components to reference box, click the object and click OK. 
 

7. If the referenced object is in another report, click the Layout Component Reference object and in 
the Properties pane, set the Embed property to specify how to store the referenced object in the 
report: 

 
 Click Copy to store a copy of the object. 
 

The copy is not automatically updated if the source object is modified. 
 Click Reference to store a reference, or pointer, of the object. 
 

The reference of the object is automatically updated if the source object is modified. For 
example, if you open or run the report, you see the modified object. 

 
A copy or reference of the object appears where you placed the Layout Component Reference object. 
If a source object is changed, you can update reused objects. 

 
Tip: You can also create a new report or template and add all the objects to share. All your shared 
objects then reside in a single location, like a library. 

 
 
Change a Reused Object 
 

If you reuse an object that contains other objects, you can change the child objects to something different. 
For example, you have a block object containing a text item in the page header and you decide to reuse the 
block in the page footer. However, you want the text item in the page footer block to show different text 
from that in the page header. 
 
Steps 
 

1. In the parent object to reuse, click the child object to change. 
 
2. In the Properties pane, set the Name property to a value beginning with a letter to uniquely 

identify the object. 
 

Report Studio may have already specified a name for the object. 
 

3. Select the copy of the parent object you created with the Layout Component Reference object. 
 
4. In the Properties pane, double-click the Overrides property. 
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5. In the Overrides dialog box, select the child object to change and click OK. 
 

The child object in the copy of the parent object is replaced by the following text: 
 
Drop item to override component child. 
 

6. Drag an object to replace the child object. 
 

You can replace the child object with any other object, not just an object of the same type. For 
example, if the child object is a text item, you can replace it with an image. 

 
Update Reused Objects 
 

If a report contains objects referenced in another report, you can quickly update the referenced objects if 
the source objects have changed. Shared objects are stored in the layout component cache. 
 
Steps 
 

1. Open the report to update. 
 
2. From the Tools menu, click Layout Component Cache. 

 
The Layout Component Cache dialog box appears, showing all reports that contain referenced 
objects and the source reports where the objects exist. 
 

3. To view which components are reused, click a source report. 
 

The components that are reused appear in the Components used pane. 
 

4. Click Reload Components to refresh all referenced objects. 
 

Although referenced objects are automatically refreshed when you open or run a report, clicking 
this button updates components that were changed while the report is open. 

 
5. Click Update All Component Copies to refresh all copied objects. 
 
6. Click Close. 
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Using Conditions 
 

You can define conditions to control what users see when they run a report. Conditions can apply to 
specific items in a report. For example, you can define a conditional style to highlight exceptional data, 
such as product revenue that exceeds your target. 
 
Highlight Data Using a Conditional Style 
 

Add conditional styles to your report to better identify exceptional or unexpected results. A conditional 
style is a format, such as cell shading or font color, that is applied to objects if a specified condition is true. 
 
For example, you want to automatically highlight in green the departments in your organization that meet 
their budget quotas and highlight in red the departments that go over budget. Creating conditional styles 
color-codes information in your reports so that you can find areas that need attention. 
 
You can apply multiple conditional styles to objects. For example, you can apply one style in specific cells 
and another style for the overall report. If multiple styles set the same property, such as font color, the last 
style in the list is applied. 
 
You can apply conditional styles to crosstab cells based on an adjacent value in the crosstab. 
 
You can create a conditional style once and reuse it on multiple objects in your report. You can specify the 
order in which conditional styles are applied. You can also use existing local classes as your conditional styles. 
 
You can create the following types of conditional styles. 
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You can perform a search to find objects in your report that use conditional styles. You can also view all 
the conditional styles used in your report to delete or modify them. 
 
You can also use variables to highlight data. If a report contains both conditional styles and style variables, 
the style variables are applied first and then the conditional styles are applied. 
 
Tip: The Return Quantity by Order Method sample report in the GO Data Warehouse (analysis) package 
includes conditional highlighting.  
 
Steps to Create a New Conditional Style 
 

1. Click the object for which you want to define a conditional style and click the conditional styles button  . 
 

Tip: You can also right-click the object and click Style, Conditional Styles or click the object, 
and then, in the Properties pane, set the Conditional Styles property. 

 

2. Click the add button  and click New Conditional Style. 
 
3. Select the data item to determine the condition and click OK. 

 
Depending on the type of data item you select, Report Studio selects the type of conditional style 
that you can use. 
 

4. In the Name box, type a name for the conditional style. 
 
5. To define a numeric value, date/time, date, time, or interval condition: 

 

 Click the new button  and select a value to define a threshold. 
 

The value appears in the Range column, and two ranges are created. 
 

 For each range, under Style, click one of the predefined styles to apply to the range or click 

the edit style button  and create a new style. 
 

Tip: You can also define a style for the cells in your report that have missing values. 
 

 Repeat the steps above to add other conditions. 
 

Tip: Under Style, pause the pointer over each range  to see the condition produced for that 
range. 
 

 To move a value above or below a threshold, click the arrow button  next to the value. 
 

For example, you insert a threshold value of five million. By default, the ranges are less than 
or equal to five million and greater than file million. Moving the five million value above the 
threshold changes the ranges to less than five million and greater than or equal to five million. 

 
6. To define a string condition: 
 

 Click the new button and select how to define the condition. 
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 To select more than one individual value, click Select Multiple Values and click the values. 

 
 To type specific values, click Enter Values and type the values. 

 
 To specify your own criteria, such as values that begin with the letter A, click Enter String 

Criteria and specify the condition. 
 

 For each condition, under Style, click one of the predefined styles to apply or click the edit 
style button and create a new style. Specify the style to apply to remaining values by clicking 
one of the predefined styles beside Remaining values (including future values). 

 
 Specify the order in which to evaluate the conditions. 
 

Conditions are evaluated from top to bottom, and the first condition that is met is applied. 
 

7. To apply a conditional style to a crosstab cell based on an adjacent value in the crosstab: 
 

 Click the new button, select Variance, and click OK. 
 

 Name the new conditional style and click the add button. 
 

 Type a value to define a threshold. 
 

The value appears under the Range column, and two ranges are created. 
 

 For each range, under Style, click one of the predefined styles to apply to the range or click 
the edit style button and create a new style. 

 
Steps to Reuse an Existing Conditional Style 
 

1. Click the data item for which you want to define a conditional style, and then click the conditional 

styles button  . 
 

Tip: You can also right-click the data item and click Style, Conditional Styles or click the data 
item, and then, in the Properties pane, set the Conditional Styles property. 

 

2. Click the add button  , click Use Existing Conditional Style, and select the style. 
 
Steps to Create an Advanced Conditional Style 
 

1. Click the data item for which you want to define a conditional style, and then click the conditional 

styles button  . 
 

Tip: You can also right-click the data item and click Style, Conditional Styles or click the data 
item, and then, in the Properties pane, set the Conditional Styles property. 
 

2. Click the add button  and click Advanced Conditional Style. 
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3. Type a name for the conditional style. 
 

4. Click the new button  and specify the expression that defines the condition. 
 

5. For each condition, under Style, click one of the predefined styles to apply or click the edit style button  
and create a new style. Specify the style to apply to remaining values by clicking one of the predefined styles 
beside Remaining values (including future values). 

 
6. Specify the order in which to evaluate the conditions by clicking a condition and then clicking the 

move up or move down arrow. 
 

Conditions are evaluated from top to bottom, and the first condition that is met is applied. 
 
Manage Conditional Styles 
 

You can view, modify, or delete the conditional styles that are applied to your report. You can also define a 
new conditional style. 
 
In the Report Studio options, you can specify whether to automatically delete conditional styles that are no 
longer used in a report. 
 
Step 
 

 From the Tools menu, click Manage Conditional Styles. 

 
Example - Add a Conditional Style to an Existing Report 
 

You are a report writer at The Great Outdoors Company, which sells sporting equipment. You have a report 
that compares current year data to previous year data and highlights negative percentage variances in red 
(Poor) and positive percentage variances in green (Excellent). You want to add a third conditional style to 
indicate percentage variances above 0 but less than 10. You create a conditional style that highlights 
percentage variances between 0 and 10% in yellow (Average). 
 
Steps 
 

1. Open the GO Balance Sheet as at Dec 31 2006 report from the GO Data Warehouse (analysis) 
package. 

 
2. Right-click any cell in the % Variance column and click Style, Conditional Styles. 

 

3. Select Conditional Style 1 and click the edit button  . 
 

4. Select the first advanced condition listed and click the edit button. 
 

5. Delete =0 from the expression definition. 
 

6. Click the Functions tab, and then expand the Operators folder. 
 

7. Double-click between, and then click after between in the expression, add a space, and type 0. 
 

8. Double-click and, and then click after and in the expression, add a space, type .1, and click OK. 
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9. From the Style box associated with this condition, click Average. 

 
10. Select the second advanced condition listed and click the edit button. 

 
11. Replace >0 in the expression with >.1 and click OK. 

 
12. Leave the style associated with this condition as is. 

 
13. Run the report. 
 
The new conditional style appears in the % Variance column. 

 

 

 
Highlight Data Using a Style Variable 
 

Highlight data in your report to better identify exceptional results. For example, you want to identify sales 
representatives who have exceeded their quota. You create a condition that checks whether each 
representative's sales for the year is greater than their quota for the year. 
 
Style variables are useful if you are working with reports that were created in a previous version of IBM 
Cognos 8 or if you want to use language variables to specify conditional styles. 
 
You can also use conditional styles to highlight data. If a report contains both conditional styles and style 
variables, the style variables are applied before the conditional styles. 
 
Steps 
 

1. Create a variable and define the condition that determines if the data will be highlighted. 
 

2. In the work area, click the column to highlight based on the condition. 
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3. In the Properties pane, double-click the Style Variable property. 
 

4. Click Variable, click the variable to assign to the object, and click OK. 
 

5. If you assigned a string variable, in the Values box, select the values for the condition to support. 
 

Tip: A default value exists for the variable, and it is always selected. 
 

6. If you assigned a language variable, in the Values box, select the languages for the condition to 
support. 

 
Tip: A default value exists for the variable, and it is always selected. 

 
7. Click OK. 

 

8. Pause the pointer over the condition explorer button  and click a value other than the default 
value. 

 
Tip: When you select a value in the condition explorer, the Explorer bar becomes green to 
indicate that conditional formatting is turned on and that any changes you make to the report apply 
only to the variable value. 

 
For example, if you created a boolean variable, click Yes. 

 
9. In the Properties pane, specify the formatting with which to highlight the column when the 

condition is satisfied. 
 

For example, click the Border property to create a thicker border around the column. 
 

10. Repeat steps 8 to 9 for other possible values defined for the variable. 
 

Tip: To view the report with no variables applied, pause the pointer over the condition explorer 
button and click (No variable) or triple-click the Explorer bar. 

 
When you run the report, the report objects to which you applied the variable are highlighted when the 
condition is satisfied. For example, if you created a boolean variable, the objects are highlighted when 
the condition is met. If the condition is not satisfied for any object, no conditional formatting is 
applied. 

 
 
Add a Variable 
 

Before you can add conditional formatting or conditional rendering to your report, you must add a variable. 
You can create a variable in the condition explorer or in the Properties pane. 
 
Steps to Add a Variable from the Condition Explorer 

1. Pause the pointer over the condition explorer button  and click Variables. 
 
2. In the Insertable Objects pane, drag one of the following variables to the Variables pane: 

 
 To create a variable that has only two possible values, Yes and No, drag Boolean Variable. 
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 To create a variable whose values are string-based, drag String Variable. 
 
 To create a variable whose values are different languages, drag Report Language Variable. 

 
3. If you created a boolean variable, in the Expression Definition box, define the condition and click OK. 
 

For example, the following expression returns the value Yes if revenue is less than one million and 
the value No if revenue is greater than or equal to one million: 

 
[Revenue]<1000000 

 
4. If you created a string variable, do the following: 
 

 In the Expression Definition box, define the condition and click OK. 
 

For example, the following expression returns the value high if revenue is greater than one 
million and the value low if revenue is less than or equal to one million: 

 
if ([Revenue]>1000000) then ('high') else ('low') 

 

 Click the add button  in the Values pane. 
 
 For each value that the variable can assume, type the name of the value that corresponds with 

the possible outcomes defined in the expression. 
 

For example, in the previous expression, you must create two values for the variable, high and low. 
 

Tip: You can create a group by clicking two or more values and then clicking the group 

values button  . For example, you can create a group that includes the available French 
languages. 

 
5. If you created a language-specific variable, in the Languages dialog box, select the languages to 

support. 

 



 - 90 - 

Steps to Add a Variable from the Properties Pane 
 

1. Select the report object. 
 

2. In the Properties pane, under Conditional, double-click the conditional property to which to 
assign the variable. 

 

The following conditional properties are available: 
 

 
 

3. In the Variable box, click an existing variable or one of the following variable types: 
 

 <New language variable> 
 

 <New string variable> 
 

 <New boolean variable> 
 

4. In the New Variable dialog box, in the Name box, type the name of the variable. 
 

 

5. If you created a string variable, click the add button  , type the string values to define, and 
click OK. 

 

6. If you created a language variable, select the languages to support and click OK. 
 

7. In the Expression Definition box, define the condition. 
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Hide or Show an Object 
 

You can hide and show objects in a report based on a condition you define. 
 
You can also specify that an object should not be rendered based on a condition. 
 
Tip: The Global Bonus Report sample report in the GO Data Warehouse (analysis) package includes 
hidden objects.  
 
Steps 
 

1. Create a variable, and define the condition that determines if the object is shown or hidden. 
 

Tip: Create a boolean variable to show and hide objects, as this type of variable has only two 
possible values. 
 

2. In the Insertable Objects pane, on the Toolbox tab  , drag a Conditional Blocks object to 
the work area. 

 
3. Select the conditional block. 

 
4. In the Properties pane, double-click the Block Variable property. 

 
5. In the Variable box, click the variable you created and click OK. 

 
6. Set the Current Block property to Yes. 

 
7. In the Insertable Objects pane, drag the object to show or hide to the conditional block. 

 
For example, drag a data item from the Source tab or from the Data Items tab. 
 
You may need to link the report page to a query before you can add a data item to the block. 

 
When you run the report, the report objects to which you applied the variable are visible when the 
condition is satisfied and invisible when it is not. 
 

Add Conditional Rendering 
 

Add conditional rendering to specify which objects are rendered when a report is run. This is useful when 
your report contains sensitive data.  
 
Conditional rendering is not the same as hiding objects. When you hide an object, the object exists but is 
transparent. If an object is not rendered, it is not in the report. 
 
Steps 
 

1. Select the list column to be rendered conditionally. 
 

Tip: You must select the list column, not the list column body or the list column title. If the 
body or title is selected, as indicated in the Properties pane, click the select ancestor button 

 and click the list column. 
 

2. In the Properties pane, double-click the Render Variable property. 
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3. Click Variable and click the variable that will determine if the column will be rendered. 
 

4. In the Render for box, select the values that the condition will support. 
 

Tip: A default value exists for the variable, and it is always selected. 
 
Example - Create a Conditional Report 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a report that shows orders after a date specified by the user. The report will prompt the 
user for a date and ask whether the user wants to see a description for each order. 
 
Steps to Create a Report 
 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 
2. In the Welcome dialog box, click Create a new report or template. 

 
3. In the New dialog box, click List and click OK. 

 

4. In the Insertable Objects pane, on the Source tab  , expand Sales and Marketing (query), 
and Sales (query) and add data items to the list: 

 
5. ●    Expand Time dimension and add Date. 
 

●    Expand Sales order and add Order number. 
 

●    Expand Product and add Product name and Product description. 
 
●    Expand Sales fact and add Quantity, Unit price, and Revenue. 
 

6. Click Date, and then click the section button  . 
 

7. Select the Order Number column and click the group button  . 
 

8. Click Revenue, and then click the aggregate button  and click Total. 
 

9. Change the title of the report to New Orders. 
 

10. Pause the pointer over the page explorer button  and click Prompt Pages. 
 

11. Create a new prompt page by double-clicking Page in the Insertable Objects pane. 
 

12. Double-click the new prompt page. 
 

13. In the Insertable Objects pane, on the Toolbox tab  , double-click Text Item and type the 
following text: 

 
Enter the start date, and select if descriptions will be shown. 
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14. Insert a 2 by 2 table into the prompt page by clicking the insert table button  and moving the 
pointer until four squares are highlighted in a 2 by 2 pattern. 

 
15. In the Insertable Objects pane, on the Toolbox tab, drag a Text Item into the upper-left cell and 

type the following text: 
 

Starting Date 
 

16. In the Insertable Objects pane, drag a Text Item into the lower-left cell and type the following 
text: 

 
Show Descriptions 

 
17. In the Insertable Objects pane, drag a Date Prompt into the upper-right cell. 
 
18. In the Prompt Wizard window, select Create a new parameter, type p_Date in the space 

provided, and then click Next. 
 

19. In the Create Filter window, select Create a parameterized filter with the following entries: 
 

 For Package item, click the ellipsis (...) button and open Sales (query) and Time dimension, 
and then click Date. 

 
 For Operator, click >. 

 
20. Click Finish. 

 
21. In the Insertable Objects pane, drag a Value Prompt into the lower-right cell. 

 
22. In the Prompt Wizard, in the Choose Parameter window, select Create a new parameter, type 

p_ShowDesc in the space provided, and then click Finish. 
 

23. Select the Value Prompt and, in the Properties pane, double-click Static Choices. 
 

24. Click the add button  . 
 

25. In the Edit dialog box, type Yes in both the Use and Display boxes. 
 

26. Click the add button. 
 

27. In the Edit dialog box, type No in both the Use and Display boxes. 
 

28. Click OK. 
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Steps to Add Conditions 

1. Pause the pointer over the condition explorer button  and click Variables. 
 
2. In the Insertable Objects pane, create a new boolean variable by double-clicking Boolean Variable. 
 
3. In the Report Expression dialog box, type the following in the Expression Definition window 

and click OK: 
 

ParamDisplayValue("p_ShowDesc") = 'Yes' 
 

4. In the Properties pane, set the Name property to showDesc. 
 

5. Pause the pointer over the page explorer button  and click the report page. 
 

6. Click the Product descriptions column. 
 

7. In the Properties pane, click the select ancestor button  and click List Column. 
 

8. In the Properties pane, set the Render Variable property to the showDesc Boolean variable you 
created. 

 
9. Run the report. 

 
The report prompts you for a date provides orders that occur after the date you entered. The report also asks 
whether to show the Descriptions column, and the column is rendered only if you choose Yes. 

 
Set the Default Data Formats 
 

Set the default data properties for each type of data, including text, number, currency, percent, date, time, 
date/time, and time interval. 
 
Steps 
 

1. From the Data menu, click Default Data Formats. 
 
2. In the Format type box, click a format type. 

 
The properties that you can set for the selected format type appear in the Properties box. 

 
3. If you clicked the Currency format type and require different currencies in the report, click the 

add button  and select currency check boxes. 
 

For example, you may have one column with values are in euros and another column whose 
values are in US dollars. 

 
4. Set the properties. 
 

If you added currencies in step 3, click each one and set the properties. If you did not add any 
currencies, any properties you set will apply to all currencies. 
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For properties in which you type meta-characters that represent certain types of information, such 
as YYYY-MM-DD for dates, the meta-characters that are required depend on the authoring 
language specified for the report.  
 
If you set a value for the Pattern property, all other formatting properties are ignored with the 
following exceptions: 
 

 Missing Value Characters 
 

 Zero Value Characters 
 

 Negative Pattern 
 

Some properties are language-sensitive and should be changed only with caution. 
 

The data formatting properties you set are applied to objects only in the current layout. If a data item 
contains values in multiple currencies but only a subset of those currencies have defined formats, the 
default format for the locale in which you are working is applied to values with no specified format. 

 
Specify What Appears for Data Containers that Contain No Data 
 

You can specify what appears for a data container when there is no data available. For example, you can 
have text appear that states that there is no data available for a list object in a report. This can be done for 
lists, crosstabs, charts, maps, repeaters, repeater tables, and tables of contents. 
 
Tip: The No Data sample report in the GO Sales (analysis) package includes data containers that have no data. 
 
Steps 
 

1. Click a data container. 
 

2. In the Properties pane, click the select ancestor button  and click the data container 
type. 

 
For example, if the data container is a list, click List. 
 

3. Set the No Data Contents property to Yes. 
 

Two tabs appear at the top of the data container. 
 

4. Click the No Data Contents tab  . 
 
5. In the Insertable Objects pane, on the Toolbox tab, insert the objects to appear when 

there is no data available. 
 
 
 



 - 96 - 

Add a Page to a Report 
 

Reports may contain pages with a variety of content. Pages may be added to create a multiple-page report. 
For example, you are creating a sales report and you want to include general information about the 
company. You decide to create an introduction page to show this information. When you run the report, 
page 1 of the report is the introduction page and the following pages contain data. 
 
Tip: The TOC Report sample report in the GO Data Warehouse (query) package includes multiple pages.  
 
You can also create page sets to control the rendering of pages in a report. 
 
Steps 
 

1. Pause the pointer over the page explorer button  and click Report Pages. 
 

Tip: Click Prompt Pages to add a prompt page. 
 

2. In the Insertable Objects pane, on the Toolbox tab  , drag Page to the work area. 
 
3. To change the order of pages, drag pages above or below other pages. 

 
4. To associate a query to the page, in the Properties pane, set the Query property to the query. 

 
Associate the page to a query to add data-related objects directly to the page header, body, or 
footer, such as data items and filters. 

 
5. Double-click the page to open it in page design view. 
 
6. Add objects to the page. 

 
Create a Page Break or Page Set 
 

You can create simple page breaks, or you can create advanced page sets to associate pages with a query 
structure to force page breaks. For example, a query contains the data item Product line, which is grouped. 
Creating a page set that is associated with this query adds page breaks for each product line. When working 
with dimensional data, you can use the Page layers area to show values on a separate page for each member. 
 
Tip: The Global Bonus Report sample report in the GO Data Warehouse (analysis) package includes page sets. 
 
Steps to Create Simple Page Breaks 
 

1. Click the data item at which the report should break to a new page. 
 
2. From the Structure menu, do one of the following: 

 
 To create a page break without creating a master detail relationship, click Set Page Break. 
 
This option only works if the data item is in a list or repeater. If the data item is in a crosstab or 
chart, Report Studio creates a page break using a master detail relationship. Setting page breaks 
without using master detail relationships can improve performance when running the report. 

 
 To create a page break using a master detail relationship, click Set Page Break Using 

Master/Detail. 
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Report Studio confirms the page break setting. 
 

Tip: To modify simple page break settings, pause the pointer over the page explorer button  
and click Report Pages, and then select and modify the page set. 
 

Steps to Create Advanced Page Sets 

1. Pause the pointer over the page explorer button  and click Report Pages. 
 
2. Create the report pages. 

 

3. In the Insertable Objects pane, on the Toolbox tab  , drag the Page Set object to the 
Report Pages pane. 

 
4. In the Properties pane, set the Query property to the query to associate with the page set. 

 
5. Organize the pages in the report by dragging report pages to page sets. 

 
6. Insert the page containing details in the Detail Pages folder. 

 
Detail pages are the pages that repeat based on the items by which you group in the following step. 

 
Tip: You can insert multiple detail pages into the same page set and link them using a master 
detail relationship. 
 

7. Define the grouping structure for the page set: 
 

 Click the page set. 
 

 In the Properties pane, double-click the Grouping & Sorting property. 
 

 In the Data Items pane, drag the data item by which to group data items to the Groups folder 
in the Groups pane. 

 
To sort the data within each group, in the Data Items pane, drag the data item by which to sort 

to the Detail Sort List folder, and then click the sort order button  to specify the sort 
order. 
  

8. Repeat steps 3 to 7 to create other page sets. 
 

Tip: You can nest page sets and join them by defining a master detail relationship. 
Create nested page sets to have pages occur within other pages. For example, you want pages 
containing product type information to occur within pages containing product line information. 

 
Note: Grouping an item for a page set is not the same as grouping a column in the layout. 
Grouping a column in the layout visually shows groups in a report. Grouping an item for a page set 
groups the item in the query. If you want to use an item that is already grouped in the layout, you must 
still perform step 7. 
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Example - Preparing a Product List Report 
 

You are a report author at The Great Outdoors Company, which sells sporting equipment. You are 
requested to create a multiple-page report showing all products sold by the company. You are asked to 
create title and end pages and to have each product line appear on a new page preceded by a header page 
and followed by a footer page. 
 
Steps 
 

1. Open Report Studio with the GO Data Warehouse (query) package. 
 
2. In the Welcome dialog box, click Create a new report or template. 

 
3. In the New dialog box, click List and click OK. 

 

4. In the Insertable Objects pane, on the Source tab  , expand Sales and Marketing (query), 
Sales (query), and Product, and double-click the following: 

 

 Product line 
 

 Product type 
 

 Product name 
 

5. Expand Sales fact and double-click Product cost. 
 
6. Group the Product line and Product type columns. 

 

7. Pause the pointer over the page explorer button  and click Report Pages. 
 

8. In the Insertable Objects pane, drag Page Set to the work area and associate it to Query1. 
 

9. In the Insertable Objects pane, drag Page to the work area four times to add four new pages. 
 

10. For each page, click the page, and in the Properties pane, set the Name property as follows: 
 

 Title page 
 

 End page 
 

 Product Line Header 
 

 Product Line Footer 
 

11. For each page you just created, add objects. 
 

For example, add a text item to each page to uniquely identify it. 
 

12. Rename the Page1 page, which contains the list, to List. 
 
13. Click the page set and, in the Properties pane, double-click the Grouping & Sorting property. 
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14. In the Data Items box, drag Product line to the Groups folder in the Groups box and click OK. 
 
15. Organize the report pages into the following hierarchy by dragging them to the appropriate location. 

 

 
 

When you run the report, the following pages appear: 
 
 Title page 
 
 Product line header page 

 
 A page for Product line_1 

 
 Product line footer page 

 
 Product line header 

 
 A page for Product line_2 

 
 Product line footer 

 
 ... 

 
 End page 

 
 

 
 


